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1 Welcome to the Clay Tablet Connector for Oracle WebCenter Sites

Welcome to the Clay Tablet Connector for Oracle WebCenter Sites ("Connector"). The Connector enables you to
automate sending and retrieving assets from Oracle WebCenter Sites, which dramatically reduces the effort
required to create, maintain, and publish Web content in multiple languages.

1.1 The Translation Lifecycle

The translation lifecycle is the broad process of selecting content, sending it out for translation, and then
receiving the translated content back from translation.

This set of steps usually fits inside a larger, more general process called the content lifecycle, which is the
process of creating, reviewing, editing, approving, and publishing content.

When you consider the translation lifecycle and the content lifecycle together, you have the global content
value chain, which is the strategy for managing multilingual content.

The content lifecycle and the translation lifecycle are impacted by the workflow steps you implement in Oracle
WebCenter Sites to manage multilingual content.

Remember that localizing content is a subset of steps in the broader content lifecycle. This willimprove your
focus on key localization considerations, improve processes, and keep all content stakeholders included.
Together, this results in better content management.

1.2 How the Connector Helps You Manage Your Translation Lifecycle

The Clay Tablet Connector for Oracle WebCenter Sites ("Connector") is a plug-in module for Oracle WebCenter
Sites. It provides a range of features and user interface enhancements in Oracle WebCenter Sites that enable
you to select, send, monitor, and retrieve content for translation into any language Oracle WebCenter Sites
supports.

These features automate the process, which dramatically reduces the effort and time required to export and re-
import content that needs to be localized. This is very helpful when translating large volumes of content or
ensuring that translated content is quickly re-imported to meet deadlines.

When you use the Connector, you manage your translation lifecycle entirely from within Oracle WebCenter
Sites:

1. The Connector exports your content from Oracle WebCenter Sites in XML format and delivers these content
files to the central, hosted Clay Tablet Platform.

2. The Clay Tablet Platform delivers your content to your translation providers, based on routing rules that
your company chooses and Clay Tablet Technologies implements.

3. When the translated content is ready, the Clay Tablet Platform retrieves it from your translators and delivers
it to the Connector.

4. The Connector automatically re-imports the content into the correct location in Oracle WebCenter Sites.
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You can then review, revise, reject, or publish the translated content as needed.

Note: Neither the Connector nor the Clay Tablet Platform performs any translation. Similarly, Clay Tablet
Technologies does not provide any translation services. Your company chooses the translation provider that
performs the translation.

1.3 Using this Guide

Purpose of this guide

This guide describes how to use the Clay Tablet Connector ("Connector") for Oracle WebCenter Sites ("OWCS")
to manage your translation lifecycle. It describes how to send out OWCS assets for translation and receive them
back from translation.

Who should use this guide

This guide is intended for content editors, project, marketing, localization or translation managers, or others
who are responsible for creating, editing, or approving assets for translation that reside in your OWCS CMS.
This guide is also useful for translation providers who receive assets from your OWCS CMS, because it describes
your company's translation management process.

What your company setup should be

This document assumes that:
B Your company already has a functioning instance of OWCS .
B The Connector has been installed, configured, and tested on your OWCS instance.

B Clay Tablet Technologies has set up the Clay Tablet Platform to send assets to your translation providers.

What you should already know

This document assumes that:

B You are familiar with the Connector's configuration for your OWCS CMS, and the reasons for choosing
certain configuration options. This is important because your company's configuration determines which
features are available.

B You have a strong working knowledge of OWCS.
B You are familiar with your company's translation process and requirements.
B You have valid user credentials to log into OWCS.

B You have the required permissions to access the Connector functionality described in this guide.
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Note: Not all the features described in this guide may be available. Feature availability depends on both your
company's Connector setup and the roles to which you are assigned. If you cannot access functionality that
you need, contact your company's OWCS administrator.

How this guide is organized

This guide contains the following chapters:

Chapter

Description

"Welcome to the Clay Tablet
Connector for Oracle
WebCenter Sites" on page 5

A brief description of the Clay Tablet for OWCS solution and how it fits into
the translation lifecycle. It also includes information about this guide and
Clay Tablet Technologies Support contact information.

"Getting Started with the Clay
Tablet Connector for Oracle
WebCenter Sites" on page 11

How to get started and an overview of the Connector interface and key
features.

"Collecting Assets for
Translation" on page 17

How to collect assets for translation.

"Adding Assets to Translation
Jobs" on page 33

How to add collected assets to new or existing translation jobs.

"Sending Out Jobs for
Translation" on page 46

How to send out jobs for translation.

"Monitoring the Translation
Status of Assets and Jobs" on
page 47

How to monitor the translation status of assets and jobs that you sent out
for translation.

"Post-Translation Tasks" on
page 57

How to perform post-translation tasks, including approving translated
assets and archiving jobs.

"Using Workflow to Manage
the Translation Process" on
page 63

How to use workflow to manage the translation process.
Important: This feature is available only if your company has configured
theCT: Approval for Content workflow.

"Administrative Tasks" on page
72

How to perform administrative tasks from the Clay Tablet Dashboard
interface.

How to find out more about the Clay Tablet Connector for OWCS

For information on installing and configuring the Clay Tablet Connector for OWCS, read the Clay Tablet
Connector for Oracle WebCenter Sites Installation and Configuration Guide.
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Documentation conventions

This guide uses the following conventions:

Convention | Description

Bold Highlights screen elements such as buttons, menu items, and fields.
Courier Highlights input, file names, and paths.

Italics Highlights terms for emphasis, variables, or document titles.

> Indicates a menu choice. For example, "Select Translation > Translate Asset."

1.4 How to Contact Clay Tablet Support

Email @: support@clay-tablet.com

Telephone: +1-416-363-0888

You can submit a support ticket either:

B by email

B from the Clay Tablet Zendesk page, using your web browser

To submit a support ticket:

1. Do one of the following:

1.4 How to Contact Clay Tablet Support

# Email support@clay-tablet.com, and cc (carbon copy) anyone to include in the ticket correspondence.

Important: Include the information and attachments in your email that are listed in the sub-sections

below.

# Create a ticket in Zendesk:

a. Open the Clay Tablet Zendesk page in your browser: https://claytablet.zendesk.com.

b. Sign in to Zendesk. If you do not have sign-in credentials, see "To view and update your support ticket
in Zendesk:" below.

Important: Include the information and attachments that are listed in the sub-sections below.

c. Click Submit a request.

d. Inthe CCs field, add anyone to include in the ticket correspondence.

Zendesk automatically creates a ticket and responds to everyone included in the cc field.

2. Everyonein the original cc receives updates unless they request to be removed from the ticket.

Important: Check your email spam folder (especially first-time Zendesk users) as sometimes email
notifications from Zendesk are marked as spam.
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1 Welcome to the Clay Tablet Connector for Oracle WebCenter Sites 1.4 How to Contact Clay Tablet Support
When the issue is resolved, Clay Tablet closes the ticket.

Information to include in the support ticket:

B client name

B CMS or content system name and version
B Connector or App version installed

B name of job for which the issue occurs

B date of job submission

B detailed description of the issue

B any error text—copy and paste, if applicable

Files to attach to the support ticket:

B CMS log files for the date the issue occurred
B Clay Tablet log files for the date the issue occurred

B screen capture of the issue

To view and update your support ticket in Zendesk:

Important: You must log into Zendesk to view your support tickets there.

1. Open the Clay Tablet Zendesk page in your browser: https://claytablet.zendesk.com.

2. Inthetop-right corner, click Sign in, and enter your credentials.

Note: If you do not have sign-in credentials yet, then click either Sign up or Get a password, and follow the
onscreen instructions.
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Sign in to Clay Tablet Technologies

MNew to Clay Tablet Technologies

Have you emailed us

3. Aftersigningin, click My activities to view the tickets you opened or where you are cc’d.

4. To update tickets, you can reply or attach files.

For more information, refer to "Submitting and tracking support requests" in Zendesk's Help Center guide for

end-users, at: https://support.zendesk.com/hc/en-us/articles/203664386-Help-Center-guide-for-agents-and-
end-users.

Important: Zendesk refers to a support ticket as a support request. These terms are interchangeable.
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2 Getting Started with the Clay Tablet Connector for Oracle WebCenter Sites

The Connector supports all web browsers that Oracle WebCenter Sites ("OWCS") supports.
Recommendation: Use the Firefox browser with the Connector.

To access the Connector:

1. Loginto OWCS.

2. Click the Contributor application icon .

The translation-management interface is primarily available on the Translation menu and in right-click
context menus.

Note: To access the Connector configuration and administration interface, after logging in to OWCS, click the

Clay Tablet Dashboard application icon @

2.1 Key Features

The Clay Tablet Connector for OWCS ("Connector") has the following key features:
B "Managing Translations with Workflow" on page 11

B "Multiple Ways to Collect Assets for Translation" on page 12

B "Multiple Ways to Manage Collected Assets" on page 12

B "Optimizing Translation" on page 12

B "Selecting a Translation Provider" on page 12

B Copying an asset directly from the source locale to the target locale. This is useful when there is content that
you do not want to translate, but that you want to include in the target version.

2.1.1 Managing Translations with Workflow

If properly configured, you can usethe CT: Approval for Content workflow with the Connector to
manage your translations. To use the workflow with the Connector, you put assets in the workflow in the
Contributor interface. Using the workflow with the Connector has the following advantages:

B You may receive email notifications when an asset is translated or assigned to you.

B Your company may have extended and integrated the final step of the CT: Approval for Content
workflow with other workflows. For example, this workflow may be configured so that the asset is assigned
to an additional person for review and approval before publication, for example, a legal review.

B You may be able to assign due dates to assets.

B You may be able to delegate your assignments to other people.
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2 Getting Started with the Clay Tablet Connector for Oracle WebCenter Sites 2.1.2 Multiple Ways to Collect Assets for Translation

For more information and detailed instructions, see "Using Workflow to Manage the Translation Process" on
page 63.

In order for the workflow process to work as described above, it must be configured. For detailed configuration
instructions, refer to the Clay Tablet Connector for Oracle WebCenter Sites Installation and Configuration
Guide.

2.1.2 Multiple Ways to Collect Assets for Translation

There are multiple ways to use the Connector to collect assets for translation:

B You can collect a single asset for translation. For details, see "Collecting One Asset for Translation" on page
17.

B You can simultaneously collect multiple assets for translation, from either the Site Tree or the Content Tree.
For details, see "Collecting Multiple Assets for Translation" on page 23.

2.1.3 Multiple Ways to Manage Collected Assets

There are multiple ways to manage collected assets:

B You can create a new job for the assets. This is described in both "Collecting One Asset for Translation" on
page 17 and "Collecting Multiple Assets for Translation" on page 23.

B You can add the collected assets to an existing job. This is described in both "Collecting One Asset for
Translation" on page 17 and "Collecting Multiple Assets for Translation" on page 23.

B You can send the collected assets to the Translation Queue, so that you can add them to jobs later. For
details, see "Adding Assets in the Translation Queue to Jobs" on page 33.

2.1.4 Optimizing Translation

The Optimize Translation feature helps you reduce translation costs, by reducing the quantity of content that
Connector sends to translation providers. It sends only changed content fields out for translation. To do this, it
checks each field in the source version of the asset for any content changes, and it sends only changed fields out
for translation. If an assets was previously translated and it has not changed, then the Connector does not send
it for translation again: Instead, it uses the stored translation.

You specify this feature by selecting the Send Modified Fields Only check box when you collect one or more
assets to send out for translation. When this check box is selected, the Connector sends out for translation only
changed content fields in the assets. If a field was previously translated and it has not changed, then the
Connector does not send it for translation again: Instead, it uses the stored translation.

2.1.5 Selecting a Translation Provider

If your company has multiple translation providers, your company's Connector setup may enable you to select
which one to use when you send out assets for translation.
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This feature is available whenever you send out a job for translation.

2.2 The Connector at a Glance
The Connector has two main interfaces in OWCS:

B The Contributor interface, which you open by this clicking this application icon . This is the part of the

Connector that you use for day-to-day translation-management tasks, such as sending out assets for
translation, and receiving assets back from the translation provider.

# The Connector installs a Translation menu in this interface.

Important: If your site has menu customization in the Contributor interface, this may override the
Connector's customization, which can prevent the Translation menu from being displayed. If this
happens, ask your OWCS administrator to enhance the menu customization in the Contributor interface,
so that the site displays the Translation menu. For example, the avisports site, which is included in the
OWSC installation, has menu customization that overrides the Connector's customization, which
prevents the Translation menu from being displayed.

# The Connector installs context-menu items.

Any user with the CTUser role for the specified site can access this interface.

Content Edit View Transation

Translation Queue
Job Status
FirstSitell Site 4
= | Transiate Asset
+ [ Detaul
+/ [ Unplaced Pages ]
£ Bookmarks (0) #+ 0 (L] Assignments (4) + @
{ |
About Clay Tablet
Asset Hame & Action to Take Assigned by Due (Days)
fwadmin
fwadmin
Content Tree
= " * o
My Work W= Saved Searches (0) o ¥, Chedkouts (0) +

m The Clay Tablet Dashboard interface, which you open by clicking this application icon . This is the

configuration and administration part of the Connector. This interface is described differently, depending on
the role assigned to your user.

Note: This guide describes the administration part of this interface, while the Clay Tablet Connector for
Oracle WebCenter Sites Installation and Configuration Guide describes the configuration part of this
interface.

How this interface is displayed to users with the CTUser role:
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2 Getting Started with the Clay Tablet Connector for Oracle WebCenter Sites 2.2 The Connector at a Glance
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How this interface is displayed to users with the CTSiteAdmin role:
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Dashboard

Configuration Management
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spechfic configuration of the integration. translation requests, and exceptions.

PO Numbers Configuration Vie
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Instalation and Configuration Guide of content for

ser Guide For more information about Clay Tablet, vist the Clay Tablet website,

How this interface is displayed to users with the CTAdmin role:
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2 Getting Started with the Clay Tablet Connector for Oracle WebCenter Sites 2.3 How to Manage Translations with the Connector

u}ﬁ fwadmin  Froseen @ L
o .

Management

Configuration Management Localke Tools
This component provides the main control center for deployment- These management took allow you to view the detais about al jobs, These locale took allow users to enable globzlzation drectly in WCS
specfic configuration of the integration. franslation requests, and exceptions. without having to go through multiple configuration screens.
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2.3 How to Manage Translations with the Connector

When you use the Connector to manage translating assets in OWCS, you complete the following general steps:
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2 Getting Started with the Clay Tablet Connector for Oracle WebCenter Sites

1. Collect assets for translation.

2. Add assets:

! toanewjob
to an existing job
# to the Translation Queue (add these assets to a job later)

3. Optional. If assets were added to a job, save the job.
4. Send out the job for translation.

5. Optional. Monitor job.

The translation provider translates assets, and translated assets return
from translation.

Note: If you configure the translation job to put the target asset into a
workflow state, then you can configure the workflow steps to send out
email alerts when the asset returns from translation. For more
information, refer to the appropriate version of the OWCS
documentation at
http://www.oracle.com/technetwork/middleware/webcenter/sites/doc
umentation/index.html.

6. Approve the translated assets so that they can be published.

7. Optional. Archive the completed job.

Note: Administrators can archive incomplete jobs.

Clay Tablet Connector for Oracle WebCenter Sites User Guide
Version 1.1.7
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3 Collecting Assets for Translation

The first step in sending assets out for translation is collecting them. After you collect assets, you organize them
into jobs. Each job can contain one or more assets.

Important: OWCS supports assets that are either Web pages or attachments, such as Microsoft Word files.
However, the Connector supports sending out for translation only assets that are Web pages. The Connector
does not support sending out for translation assets that are attachments.

You collect assets for translation in the Contributor interface:

When an asset is selected in the Site Tree or in the Content Tree in the navigation pane on the left, you can
select Translation > Translate Asset from the menu.

If the Site Tree bar is selected at the bottom of the navigation pane on the left, then you can right-click on an
asset in this tree and select Translate or Translate Branch from the context menu that opens.

If the Content Tree bar is selected at the bottom of the navigation pane on the left, then you can right-click
on an asset in this tree and select Translate or Translate Children.

There are multiple ways to collect assets for translation:

For instructions on collecting a single asset for translation, see "Collecting One Asset for Translation" on page
17.

For instructions on collecting multiple assets for translation, see "Collecting Multiple Assets for Translation"
on page 23.

Note: When you collect multiple assets, you can filter them so that you add certain ones to specific jobs or
you can send them to the Translation Queue. For details, see "Filtering Assets in a List" on page 29.

3.1 Collecting One Asset for Translation

This section describes how to collect a single asset to send for translation. After you collect this asset, you can
add it to a new or an existing job, or you can send it to the Translation Queue, so that you can add itto a job
later.

To collect one asset for translation:

1. Do one of the following:

From the navigation pane, open an asset in the Site Tree or the Content Tree, and then select Translation
> Translate Asset from the menu.

In the navigation pane, select an asset, right-click, and select Translate from the context menu.
Open the asset, and select Translation > Translate Asset from the menu.

Click the Translate this asset now link in the following scenario: You select Translation > View
Translations when an asset is in Form mode and Inspect view, and the asset has not been translated. The
following message is displayed: This asset currently has no translations.

The Translate page opens.
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3 Collecting Assets for Translation 3.1 Collecting One Asset for Translation

Translate AdvCols: FSITHotItems Target Locales
Name: FSIHotTtems —
Salact Hane
Description: Hot Items
[Jde_DE (de_DE)
ID: 1124978777055 [l es_ES (es_ES) =
LIfr_m (fi_FR)
Locale:  en US Ol (eum)
Existing Translations: Home - -
Salect Target Workflow: Do Mot Add to Workflow -
Add To Job/Queus: Quauea for Later -
Send with Dependencies:
Send Modified Fields Only:
2. Specify the following translation options:

Field Description
Name The name of the asset, which was specified when the asset was created. Read-only.
Description A brief description of the asset, which was specified when the asset was created. Read-

only.
ID OWCS's unique identifier for the asset. Read-only.
Locale The OWCS locale for the source language of the asset to send out for translation.

Read-only.
Existing Indicates whether translations already exist for this asset. Read-only.
Translations B None: There are no translations for this asset.

B |fthis asset has previously been translated, then the locales for the translated

languages are displayed.
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3 Collecting Assets for Translation 3.1 Collecting One Asset for Translation

Field

Description

Select Target
Workflow

To assign the asset to the translation workflow, select the CT: Approval for
Content workflow. Otherwise, select Do Not Add to Workflow. For more
information, see "Using Workflow to Manage the Translation Process" on page 63.

Add to
Job/Queue

Specifies the job for the asset to the Translation Queue. Select a job or one of the

following options from the list:

B Thejob name of ajob that has not yet been sent out for translation. These are jobs
that have Created status.

B Queue for Later:Sendstheassetto the Translation Queue, where it still must
be added to a job before you send it out for translation. For a list of reasons for
sending an asset to the Translation Queue, see "Adding Assets in the Translation
Queue to Jobs" on page 33.

B Create New Job: Enables you to create a new job for this asset.

Send with
Dependencies

When this check box is selected, the Connector sends out any components in the
asset for translation as separate assets.

Send Modified
Fields Only

Send out for translation only changed content fields in the asset. If a field was
previously translated and it has not changed, then the Connector does not send it for
translation again: Instead, it uses the stored translation.

Target Locales

Select the check boxes of one or more target locales for translating the asset.

B To select all locales, click Select All.

B To clear all selected check boxes, click Select None.

B To display locales that are hidden by default, click the Show X Hidden Locales link
at the bottom of the list, where X is the number of hidden locales. To hide them
again, click the Hide X Locales link. Displayed only if some locales have been hidden
by default for this site. For more information, refer to the Clay Tablet Connector for
Oracle WebCenter Sites Installation and Configuration Guide.

3. Click Next.

If you selected Create New Jobin the Add to Job/Queue list, a pop-up window opens, prompting you
to enter a name for the new job. Enter the name and click OK.

If you selected Queue for Laterinthe Add to Job/Queue list, the Translation Queue opens. For
details, see "Adding Assets in the Translation Queue to Jobs" on page 33.

If you added the asset to a new or an existing job, the Job Details page opens.
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3.1 Collecting One Asset for Translation

Job Details ¢#
Job ID: 511e5096-2Bee-4cbe-a294-19dde1bcBebe Sawe Job
Jab Mame: Transiate to Spanish m
Descripon:
Status: Created =~
Created: fwradmin (2016-08-09 15:31:29)
Last updated: 2016-08-09 15:31:29
PO Number: LJ
Due Date (yyyy-mm-dd):
Translation Provider: v
send Modified Fields Only:
Assets in this Job: Total1  Pending 1
Showing 1 total record(s), D selected.
T TS ) '
B Assct Type:ID - Asset Name Souroe Source Updated Target Last Updated Filter
Page : 1351276311107 FallAticles FR 2015-02-09 20:54:10 2016-08-09 15:31:29 Fiter only applies when there are more
than 10 assets,

4. Specify the following translation-job options:

Field Description

Job ID The Connector's unique identifier for this job. Read-only.

Job Name The name of this translation job. You can modify this name.

Description The brief description of this translation job. You can modify this description.

Status The status of this job, which is Created. For a list and description of translation-job
statuses, see page 47.

Created The username of the user who created the job, and the date and time when the job was
created, in the following format: YYYY-MM-DD hh:mm:ss. Read-only.

Last The date and time when the job was created, in the following format: YYYY-MM-DD

Updated hh:mm: ss. Read-only.

PO Number | The purchase-order ("PO") number for this job. Select a PO number from the dropdown
list. Depending on your site configuration, this field may be required, optional, or not
displayed at all. For more information, refer to the Clay Tablet Connector for Oracle
WebCenter Sites Installation and Configuration Guide.
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3 Collecting Assets for Translation 3.1 Collecting One Asset for Translation

Field Description

Due Date The date when the translated asset is due, in the following format: YYYY-MM-DD.

(yyyy-mm-

dd)

Translation Select the translation provider from the dropdown list. If Freeway is selected, the

Provider following additional fields are displayed, where you can specify the analysis codes for the
translation:

B Region: The region relevant to the content. Your Lionbridge setup determines which
regions are displayed in the list.

B Department: The department relevant to the content. Your Lionbridge setup
determines which departments are displayed in the list.

B Priority: The priority of this job. Your Lionbridge setup determines which priorities are
displayed in the list.

Assets in this | Note: For an existing job, both the new and the previous assets in the job are displayed.

Job The following information is displayed about the number of assets in this job:

B Total: The total number of assets in this job, including any assets that were previously
added to an existing job.

B Pending: The number of recently collected assets that can be added to this job.

B The number of assets displayed on this page of the asset list.

B The number of assets in the list with selected check boxes.

Clay Tablet Connector for Oracle WebCenter Sites User Guide Page 21
Version 1.1.7 December 14, 2017



3 Collecting Assets for Translation 3.1 Collecting One Asset for Translation

Field Description

Asset List The following information about the assets available to send out for translation:
Asset Type: The type of asset.
ID: OWCS's unique identifier for the asset.
Asset Name: The name of the asset, which was specified when the asset was created.
Source: The locale of the source language to send out for translation.
Tip: If you are viewing this page from the Contributor interface, you can click the link to
view the asset.
Source Updated: The date and time when the source asset was last updated, in the
following format: YYYY-MM-DD hh:mm:ss.
Note: You cannot sort by this column.
Target: The locale of the target language into which to translate the asset.
Tip: If the target asset already exists, you can click the link to view it.
Last Updated: The date and time when the target asset was last updated, in the
following format: YYYY-MM-DD hh:mm:ss.
Select the assets to send out for translation.
Important: The Connector will send out all the assets in the list for translation. To avoid
sending one or more assets for translation, select the corresponding check boxes, and
click Remove Selected to remove them from the list. A message box opens, confirming
that you want to remove the selected assets from the job. Click OK to proceed.
If there are more than 10 assets in the list, you can click the page number or change the
number of assets displayed in a page to view the other assets.
Use the following buttons to select and manage items in the list:
Select All: Selects all check boxes for the displayed assets.
Unselect All: Clears all selected check boxes for the displayed assets.
Remove Selected: Removes the assets with selected check boxes from the list.

Filter To display fewer assets in the list, in the Filter section in the bottom right corner, change
any filter settings and click Apply. This section is displayed only if there are 10 or more
assets in the list. For detailed instructions, see "Filtering Assets in a List" on page 29.

5. Do one of the following:

To save the job so that you can send it later, click Save Job. The Job Details page updates. The Status of
the Job is Created.

To send the job out for translation immediately, click Send Now. A message box opens, confirming that
you want to send out this job to the translation provider you specified earlier. Click OK to proceed. The
Status is Sending. Click View Details. The page updates. The Status is Sent to CT Platform. Inthe

asset list, the assets have SENDING TO PLATFORM status. Click the Refresh icon to refresh the
page.
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To copy the assets in the job directly from the source locale to the target locale, without sending out the
job to the translation provider, click Copy Back. This is useful when there is content that you do not want
to translate, but that you want to include in the target version. A message box opens, confirming that you
want to copy over the assets without translating them. Click OK to proceed. This overwrites any
corresponding target assets that already exist. The status of the job is Sending to copy back. Click
View Details. The page updates. The status is now Completed (copied back).

Note: To copy assets from this job to a new or an existing job, in the Copy to dropdown list, either select the
name of a job that has not yet been sent out for translation, or select Create New Job, and then click
Copy to. For detailed instructions, see "Copying Assets Between Jobs" on page 44.

Note: To delete the job before saving or sending it, click Delete Job.

3.2 Collecting Multiple Assets for Translation

This section describes how to collect a multiple assets to send for translation. After you collect these assets, you
can add them to a new or an existing job, or you can send them to the Translation Queue, so that you can add
them to one or more jobs later.

To collect multiple assets for translation:

1. Do one of the following:

If the Content Tree is displayed in the navigation pane, then select a branch, right-click, and select
Translate Children from the context menu.

Note: For a description of what happens if you select Translate from the context menu, see "Collecting
One Asset for Translation" on page 17.

If the Site Tree is displayed in the navigation pane, then select a branch, right-click, and select
Translate Branch from the context menu.

Note: For a description of what happens if you select Translate from the context menu, see "Collecting
One Asset for Translation" on page 17.

The Translate Children of Asset page or the Translate Branches of Page page opens in a new tab.
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Translate Children of Asset: FSIT Manufacturers Refine Search
= - e - —— Assel Type:
Asset Type  Asset ID Asset Name Created By Created Date  Product_p
¥ Product_p 1351276310302  FSII Innovative Ent.... Innovative Entertain... fr FR  fwadmin  July 13, 2015 M Product_C
¥ proguct P 1351276308441  FSII Innovative Ent. Innovative Entertain...  de_DE  fwadmin  March 02, 2015 Source Locale:
) fr_FR
[+ Product_P 1351276308415  FSI innovador Ent. ... Sistemas da entraten... es FS  fwadmin  March 02, 2015 ) de_DE
) es ES
¥ product_p 1351276307640  FSII FS Electronics ... FS Electronics Ltd. fr FR  fwadmin  February 13, 2015 en_UUs
oy S
[+ Product_P 1351276307613  FSI AudioCo AudioCo es FS  fwadmin  February 13, 2015
[+] Product_P 1351276307560  FSI AudioCo AudieCo de_DE fwadmin  February 13, 2015
] Product_P 1351276307534  F5II FS Electronics ... F5 Blektronik GmbH de_DE fwadmin  February 13, 2015
¥ product_p 1351276307507  FSIIFS Electronics F5 Electronics Ltd. es ES  fwadmin  February 13, 2015
[+ Product_P 1114083739036  FSII Superior System...  Superior Systems Inc... en_USs  admin Qctober 20, 2004

Important: When you collect multiple assets for translation, they must all have the same source locale. If
necessary, under Refine Search, select the radio button for the source locale of the assets to translate.

2. Ensure that the check boxes of the assets you want to send out for translation are selected, and click
Continue. If required, click the Select All and Unselect All buttons to facilitate your selection.

The Translate Multiple Assets of Type page opens.

Translate Multiple Assets of Type: Product_P Target Locales
s o it
Source Locale:  en_US [ de_DE (de_DE)
[les_ES (es_ES)
Select Target Workflow: | Do NotAddto Workflow LIfr_FR (fr_FR)
Oe_1T (2_1T)
Add To Job/Queue: Add To Queue w
I Hidde Cakls
Send with Dependencies: [

3. Specify the following translation options:
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3.2 Collecting Multiple Assets for Translation

Field Description
Number of The number of assets collected. Read-only.
Assets
Locale The OWCS locale for the source language of the assets to send out for translation.
Read-only.
Select Target To assign the assets to the translation workflow, select the CT: Approval for
Workflow Content workflow. Otherwise, select Do Not Add to Workflow. For more

information, see "Using Workflow to Manage the Translation Process" on page 63.
Add to Specifies the job for the assets or sends them to the Translation Queue. Select a job
Job/Queue or one of the following options from the list:

B Thejob name of ajob that has not yet been sent out for translation. These are jobs
that have Created status.

B Queue for Later:Sends the assets to the Translation Queue, where they still
must be added to a job before you send them out for translation. For a list of
reasons for sending an asset to the Translation Queue, see "Adding Assets in the
Translation Queue to Jobs" on page 33.

B Create New Job: Enables you to create a new job for these assets.

Send with When this check box is selected, the Connector sends out any components in the

Dependencies

assets for translation as separate assets.

Send Modified
Fields Only

When this check box is selected, the Connector sends out for translation only changed
content fields in the assets. If a field was previously translated and it has not changed,
then the Connector does not send it for translation again: Instead, it uses the stored
translation.

Target Locales

Select the check boxes of one or more target locales for translating the assets.

B To select all locales, click Select All.

B To clear all selected check boxes, click Select None.

B To display locales that are hidden by default, click the Show X Hidden Locales link
at the bottom of the list, where X is the number of hidden locales. To hide them
again, click the Hide X Locales link. Displayed only if some locales have been hidden
by default for this site. For more information, refer to the Clay Tablet Connector for
Oracle WebCenter Sites Installation and Configuration Guide.

4, Click Next.

If you selected Create New Jobinthe Add to Job/Queue list, a pop-up window opens, prompting you
to enter a name for the new job. Enter the name and click OK.

Clay Tablet Connector for Oracle WebCenter Sites User Guide
Version 1.1.7

Page 25
December 14, 2017



3 Collecting Assets for Translation 3.2 Collecting Multiple Assets for Translation

If you selected Queue for Later inthe Add to Job/Queue list, the Translation Queue opens. For
details, see "Adding Assets in the Translation Queue to Jobs" on page 33.

If you added the assets to a new or an existing job, the Translate Multiple Assets of Type page opens.

The Job Details page opens.

Job Details  4#

Al Translation Jobs
Job 1D: 23b24f47-0394-4924-b5ac-afc4ead3426b m
Job Name: Translation to German m
s e -—
Created: fwadmin (2016-D8-09 14:50:44)
Last updated: 2016-08-0% 14:50:44
PO Number: v

Due Date (yyyy-mm-dd):

Translation Provider: v

Send Medified Fields Only:

Assets in this Job: Total 5 Pending 5

Showing 5 total recordis), 0 selected.

-

B  Asset Type : ID Asset Name . Source Updated Target Last Updated Filter
Page : 1118867611428 FSIabout en_UsS 2005-08-25 01:23:... de DE 2016-08-09 14:50:44 Filter only applies when there are more
Page : 1118867611408 FSllarticles en 2015-02-06 13:12: de_L 2016-08-09 14:50:44 than 10 assets.

Page : 11237BE2D8B39 FSILogin en_US 2005-08-11 17:30: le_DE 2016-08-09 14:50:44
Page : 1124747609912 FSProducts 15 2015-02-05 16:11:... de_DE 2016-08-09 14:50:44
Page : 1124747600016 FeIIShoppingCart en_US 2005-08-22 18:13; le_DE 2016-08-0% 14:50:44

Any assets that are displayed in the list are part of the job and may be sent for translation.

5. Verify the assets in the job, and specify the following translation-job settings:

Field Description
Job ID The Connector's unique identifier for this job. Read-only.
Job Name The name of this translation job. You can modify this name.
Job The brief description of this translation job. You can modify this description.
Description
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3 Collecting Assets for Translation 3.2 Collecting Multiple Assets for Translation

Field Description

Status The status of this job, which is Created. For a list and description of translation-job
statuses, see page 47.

Created The username of the user who created the job, and the date and time when the job was
created, in the following format: YYYY-MM-DD hh:mm:ss. Read-only.

Last The date and time when the job was created, in the following format: YYYY-MM-DD
Updated hh:mm: ss. Read-only.

PO Number | The purchase-order ("PO") number for this job. Select the PO number from the dropdown
list. Depending on your site configuration, this field may be required, optional, or not
displayed at all. For more information, refer to the Clay Tablet Connector for Oracle
WebCenter Sites Installation and Configuration Guide.

Due Date The date when the translated asset is due, in the following format: YYYY-MM-DD.

Translation Select the translation provider from the dropdown list. If Freeway is selected, the

Provider following additional fields are displayed, where you can specify the analysis codes for the

translation:

B Region: The region relevant to the content. Your Lionbridge setup determines which
regions are displayed in the list.

B Department: The department relevant to the content. Your Lionbridge setup
determines which departments are displayed in the list.

B Priority: The priority of this job. Your Lionbridge setup determines which priorities are
displayed in the list.

Assets in Note: For an existing job, both the new and the previous assets in the job are displayed.

this Job The following information is displayed about the number of assets in this job:

B Total: The total number of assets in this job, including any assets that were previously
added to an existing job.

B Pending: The number of recently collected assets that can be added to this job.

B The number of assets displayed on this page of the asset list.

B The number of assets in the list with selected check boxes.
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Field

Description

Asset List

The following information about the assets available to send out for translation:
Asset Type: Thetype of asset.
ID: OWCS's unique identifier for the asset.
Asset Name: The name of the asset, which was specified when the asset was created.
Source: The locale of the source language to send out for translation.
Tip: If you are viewing this page from the Contributor interface, you can click the link to
view the asset.
Source Updated: The date and time when the source asset was last updated, in the
following format: YYYY-MM-DD hh:mm:ss.
Note: You cannot sort by this column.
Target: The locale of the target language into which to translate the asset.
Tip: If the target asset already exists, you can click the link to view it.
Last Updated: The date and time when the target asset was last updated, in the
following format: YYYY-MM-DD hh:mm:ss.
Select the assets to send out for translation.
Important: The Connector will send out all the assets in the list for translation. To avoid
sending one or more assets for translation, select the corresponding check boxes, and click
Remove Selected to remove them from the list. A message box opens, confirming that you
want to remove the selected assets from the job. Click OK to proceed.
If there are more than 10 assets in the list, you can click the page number or change the
number of assets displayed in a page to view the other assets.
Use the following buttons to select and manage items in the list:
Select All: Selects all check boxes for the displayed assets.
Unselect All: Clears all selected check boxes for the displayed assets.
Remove Selected: Removes the assets with selected check boxes from the list.

Filter

To display fewer assets in the list, in the Filter section in the bottom right corner, change
any filter settings and click Apply. This section is displayed only if there are 10 or more
assets in the list. For detailed instructions, see "Filtering Assets in a List" on page 29.

Note: To delete one or more assets from the job, select the corresponding check boxes and click Delete
Selected. A message box opens, confirming that you want to remove the selected assets from the job. Click

OK to proceed.

6. Do one of the following:

To save the job so that you can send it later, click Save Job. The Job Details page updates. The Status of
the Job is Created.

To send the job out for translation immediately, click Send Now. A message box opens, confirming that
you want to send out this job to the translation provider you specified earlier. Click OK to proceed. The
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Status is Sending. Click View Details. The page updates. The Status is Sent to CT Platform. Inthe

asset list, the assets have SENDING TO PLATFORM status. Click the Refresh icon to refresh the
page.

To copy the assets in the job directly from the source locale to the target locale, without sending out the
job to the translation provider, click Copy Back. This is useful when there is content that you do not want
to translate, but that you want to include in the target version. A message box opens, confirming that you
want to copy over the assets without translating them. Click OK to proceed. This overwrites any
corresponding target assets that already exist. The status of the job is Sending to copy back. Click
View Details. The page updates. The status is now Completed (copied back).

Note: To copy assets from this job to a new or an existing job, in the Copy to dropdown list, either select the
name of a job that has not yet been sent out for translation, or select Create New Job, and then click
Copy to. For detailed instructions, see "Copying Assets Between Jobs" on page 44.

Note: To delete the job before saving or sending it, click Delete Job.

3.3 Filtering Assets in a List

The following pages display lists of assets
The Job Details page displays the list of assets in a job.
The Translation Queue display the list of assets in the queue.
If there are more than 10 assets in the asset list:
The assets are displayed on multiple pages.
You can filter the assets displayed in the list, as described in this section.

When you filter a list, you specify one or more filter conditions. A filter condition is active and modifiable only if
it has multiple possible values. For example, suppose that the Translation Queue contains assets that will be
translated into multiple target locales. You can see this in the Target list, in the screen capture below.
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Translation Queue 44
Queuved Requests: Showing 14 total record(s), 0 selected.

Pages: 1 ( 100 ¥ | per page) v
B Asset Type: ID o Asset Name Source Updated Last Updated Filter
Content_C : 1114083739, FSIFSEIntroducesDVDReC... 2004-10-25 14:33._ | zh_( 2016-08-09 02:32:36 Currentconditions:  none
Content_C : 1114083739 FEIFSEIntroducesDVDRec 2004-10-25 14:33 th_( 2016-08-09 02:32:01 Asset Name =
Content_C : 1114083739,  FSIFSEIntroducesDVDRec... 2004-10-25 14:33._| en_GB 2016-08-09 02:32:36 Asset Type +
Content_C : 1114083739, . FSIIFSEIntroducesDVDRec 2004-10-25 14:33 | es ES 2016-08-09 02:32:01 i )

Page : 1118867611408 FslArticles 2015-02-06 13:12._ | fr_FR 2016-08-09 15:50:41 [ —
Target Language x

Page : 1118867611408 F5llArticles 2015-02-06 13:12 ru_RU 2016-08-09 15:50:41

Page : 1118867611428 FsAbout 2005-08-25 01:23..| fr_FR 2016-08-09 15:50:41 en_Ge

Pape : 1118867611428 FsllAbout 2005-08-25 01:23...) ru_RU 2016-08-09 15:50:41 e ES

Page : 1123758998830 FSILagin 2005-08-11 17:39. | fi_FR 2016-08-09 15:50:41 fi_FR

Papge : 1123788998839 FsllLogin 2005-08-11 17:39._| ru_RU 2016-08-09 15:50:41 ru_RU

Pape : 1124747609012 FslProducts 2015-02-05 16:11 ru_RU 2016-08-00 15:50:41 h_CN
Page : 1124747609912 FsIProducts 2015-02-05 16:11...) fr_FR 2016-08-09 15:50:41 Last Updated Date -
Page : 1124747609916 FsIshoppingCart 2005-08-22 18:13..) fr_ 2016-08-09 15:50:41 reated User; fwadmin

Page : 1124747609916 FsIShoppingCart 2005-08-22 18:13... \lu_FlU 2016-08-09 15:50:41 m m

e

Now suppose that you want to create a job with assets only for a particular target language (fr FR), so that
you can send these assets for translation to a particular translation provider.

You can filter the list of assets in the Translation Queue to display only those with the £r FR target language.

To filter assets in the list:

1. IntheFilter section, to the right of the asset list, click the expand icon beside the condition to filter. For
example, click the expand icon beside Target Language.

Conditions in black are available for filtering. This means that assets have different values for this
particular condition. For example, the target languages for all the assets areen GB, es ES, fr FR, ru
RU, and zh CN.

Conditions in gray are not available for filtering, because all the assets have the same value for this
condition. For example, the source language for all the assets is en_US.
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Translation Queue
Queued Requests: Showing 14 total record(s), 0 selected.
B Asset Type : 1D o Asset Name Source Source Updated Target Last Updated Filter
Content_C: 1114083729, FSIFSEIntroducesDVDRaC. en_LUS 2004-10-25 14:33, zh_CN 2016-08-00 02:32:36 Currant conditions: none
: 739 . -10-, 133 zh_ow -08- 1321
Content_C : 1114083739 FSIFSEIntroducesDVDReC en_L 2004-10-25 14:33 h_C 2016-08-09 02:32:01 Hame: +
Content_C : 1114083739, FSTIFSEIntroducesDVDRec en_LUS 2004-10-25 14:33 en_GB 2016-08-09 02:32:36
Asset Type +
Content_C: 1114083739... FSIFSEIntroducesDVDRec... en_US 2004-10-25 14:33..§ es ES 2016-08-09 02:32:01 i
Source Language: en_US
Page : 1118867611408 FsIlArticles en_Us 2015-02-06 13:12.. fr_F 2016-08-09 15:50:41
Page : 1118867611408 FeIAticles en_US 2015-02-06 13:12. n_RuU 2016-08-00 15:50:41
Last Updated Date +
Page : 1118867611428 FslAbout en_L5 2005-08-25 01:23..) fr_FR 2016-08-08 15:50:41
Created Uiser: fwadmin
Page : 1118867611428 Fslabout en_LsS 2005-D8-25 01:23, ru_RL 2016-08-00 15:50:41
oty ] et |
Page : 11237BE908839 FsILogin en_L5 2005-08-11 17:39_§ fr_FR 2016-08-08 15:50:41 -
Page : 1123768908639 FaTLogin en_Ls 2005-08-11 17:39. | ru_RU 2016-08-09 15:50:41
Page : 1124747609912 FsIProducts en_L5 2015-D2-05 16:11. ru_RU 2016-08-09 15:50:41
Page : 1124747609912 FsIProducts en_LS 2015-02-05 16:11..| fr_FR 2016-08-09 15:50:41
Page : 1124747609916 FsIIshoppingCart en_L5S 2005-D8-22 1B8:13. fr_FR 2016-08-09 15:50:41
Page : 1124747609916 FsIShoppingCart en_U 2005-08-22 18:13_ w 2016-08-09 15:50:41

The Target Language section expands.

Filter
Current conditions: none
Asset Name +
Asset Type +

Source Language: en_LIS

Last Updated Date +

Created User: fwadmin

—
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Language, select the check boxes for the target languages to filter. Then the page will display only assets that
will be translated to the specified target language.
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Condition | Filter Parameters

Asset Select one of the following parameters: contains/matches/1like, and then enter the asset
Name name or fragment in the text box.

Asset Displays all the asset types of the assets in the asset list. Select the corresponding check

Type boxes.

Source Displays all the source locales of the assets in the asset list. Select the corresponding check

Language | boxes.

Target Displays all the target locales of the assets in the asset list. Select the corresponding check
Language | boxes.

Last Select one of the following parameters: on/before/after/between, and then enter the
Updated date or dates when the asset was last updated, in the following format: YYYY-MM-DD.

Date

Created Displays all the users who created the assets in the asset list. Select the corresponding check
User boxes.

Site Displays all the sites with the assets in the asset list. Select the corresponding check boxes.

Note: This filter is displayed only in the Clay Tablet Dashboard interface.

Note: To cancel a condition, click the red close icon [*] . This removes the corresponding condition from the
filter.

3. Click Apply.

The asset list now displays only the assets that match the specified filter conditions.
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4 Adding Assets to Translation Jobs

After you collect assets, you add them to new or existing translation jobs.
B You can add assets to translation jobs immediately after you collect them.

For detailed instructions on collecting a single asset and immediately adding it to a job, see "Collecting
One Asset for Translation" on page 17.

For detailed instructions on collecting multiple assets and immediately adding them to jobs, see
"Collecting Multiple Assets for Translation" on page 23.

B You can copy assets from one translation job to another. For details, see "Copying Assets Between Jobs" on
page 44.

B You can add collected assets to the Translation Queue. Later, you add the collected assets from the
Translation Queue to new or existing translation jobs. For details, see "Adding Assets in the Translation
Queue to Jobs" on page 33.

Note: Even after you add assets to a translation job, you can still modify that job and add or remove assets,
and change job settings. For details, see "Modifying a Job before Sending It Out for Translation" on page 40.

4.1 Adding Assets in the Translation Queue to Jobs

The Translation Queue contains assets that you collected and did not immediately add to jobs. From the
Translation Queue, you can add one, multiple, or all of these previously collected assets to a new or an existing
job. You can then also send out this job for translation. Submitting assets to the Translation Queue before
sending it out for translation has the following advantages:

B You may have assets that you want to send out for translation, but you may not have decided yet how you
want to organize these assets into jobs.

B You may not want to send out each asset individually as soon as you collect it. The Translation Queue
facilitates your management of assets, so that you do not forget about sending individual assets for
translation.

B Your translation provider may prefer receiving fewer but larger batches of assets to translate, rather than
individual assets, as it facilitates project preparation, resource assignment, and file analysis.

B |fyou want to translate many assets into multiple languages, but you want to translate into only one target
language at a time, this is a good way to manage that process.

B You may want to route jobs to certain translation providers.

B You may want to add job-specific metadata, such as a purchase order number.

You submit assets for translation from the Translation Queue in the following scenarios:

B You collect a single asset for translation, and you send it to the Translation Queue. For details, see "Collecting
One Asset for Translation" on page 17.
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B You collect multiple child assets of a branch of the Content Tree, or a branch of the Site Tree, for translation,
and you send them to the Translation Queue. For details, see "Collecting Multiple Assets for Translation" on
page 23.

To open the Translation Queue, do one of the following:

B |n the Contributor interface, select Translation > Translation Queue.
B In the Clay Tablet Dashboard interface, under Management, click View All Queues.

B |nthe Contributor interface, select Queue for Later in the Add to Job/Queue dropdown list while
collecting assets for translation, either:

in the Translate page, described in "Collecting One Asset for Translation" on page 17

in the Translate Multiple Assets of Type page, described in "Collecting Multiple Assets for Translation"
on page 23

Translation Queue §4

Queued Requests: Showing 14 total record(s), 0 selected.

Pages: 1 (100 v | per page)

B Asset Type:ID o Asset Name Source Last Updated Filter
Content_C : 1114083739, FaIFSEIntroducesDVDRec en 2004-10-25 14:33. th 2016-D8-09 D2:32:36 Currant conditiofns: none
Conbent_C : 1114083739, FSIFSEIntroducesCVDRec. . | 2004-10-25 14:33. zh 2016-08-09 02:32:01

- Asset Hame +
Content_C : 1114083739 FETIFSEIntroduc esDAVDREC an_ 2004-10-25 14:33 en_GB 2016-08-09 02:32:36
Asset Type +
Conbent_C : 1114083739, FSIFSEIntroducesDVDRec..  en 2004-10-25 14:33. @5 ES 2016-08-09 02:32:01
ul N
Page : 1118867611408 FslArticles m 2015-02-06 13:12. 2016-08-09 15:50:41
Target Language +
Page : 111EB67611408 PSIArticles en 2015402-06 13:12. u_RL 2016-08-09 15:50:41
Last Updated Date +
Page : 1118867011428 FSIlabout en 2005-08-25 01:23... fr_FR 2016-08-09 15:50:41
Created User: fwadmin
Page : 1116867611428 FsIabout en_ 2005-08-25 01:23 u_RL 2016-08-09 15:50:41
i il
Page : 1123788998839 FaIllogin en_US 2005-08-11 17:39. 2016-08-09 15:50:41 -

Page : 1123788998839 FSILogin en 2005-08-11 17:39 n_RL 2016-08-09 15:50:41

Page : 1124747609912 FsIProducts en 2015-02-03 16:11... m_RU 2016-08-09 15:50:41

Page : 1124747609912 FSIlProducts n 2015-02-05 16:11. 2016-08-09 15:50:41

Page : 1124747602016 FsIshoppingCart en 2005-08-22 18:13,... fi_FR 2016-08-09 15:50:41

Page : 1124747609916 FSIIShoppingCant &n_US 2005-08-22 18:13. n_RU 2016-08-09 15:50:41

The Translation Queue ("queue") displays all assets that were previously collected for translation, were sent to
the Translation Queue, and have not yet been added to translation jobs for a particular site.

Tip: To update your view of the assets in the Translation Queue, click Refresh in the top-left corner of the page.

Note for administrators: If you are assigned either to the CTSiteAdmin role for multiple sites or to the
CTAdmin role, and you open the Translation Queue from the Clay Tablet Dashboard interface, then you can
use the Site dropdown list in the top right corner of the queue to select which site's assets to view.

If there are more than 10 assets in the queue, the assets are displayed in multiple pages in the queue.
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¥ To navigate among pages in the list, click the corresponding page number.

P To display more assets in a page, select the number to display (20, 50, 100) from the dropdown list.

F To display fewer assets in the list, in the Filter section in the bottom right corner, change any filter settings
and click Apply. This section is displayed only if there are 10 or more assets in the list. For detailed
instructions, see "Filtering Assets in a List" on page 29.

The following information is displayed about assets in the Translation Queue:

Column Description

Asset Type The type of asset.

ID OWOCS's unique identifier for the asset.

Asset Name The name of the asset, which was specified when the asset was created.

Source The locale of the source language to send out for translation.
Tip: If you are viewing this page from the Contributor interface, you can click the link to view
the asset.

Source The date and time when the source asset was last updated, in the following format: YYYY-

Updated MM-DD hh:mm:ss.

Target The locale of the target language into which to translate the asset.

Last Updated | The date and time when the target asset was last updated, in the following format: YYYY-
MM-DD hh:mm:ss.

Once the assets to you want to group together are displayed in the list, you add them to a job.

To add one or more assets in the queue to a job:

1. Select the check boxes for the assets to add to a job.

Tip: To facilitate this, use the Select All and Unselect All buttons, or click the check box in the column

heading.

Note: To delete one or more assets from the queue, select the corresponding check boxes and click Delete
Selected. A message box opens, confirming that you want to remove the selected assets from the queue.
Click OK to proceed. The deleted assets are no longer available to add to jobs directly from the queue.

2. Inthejob dropdown list, do one of the following:

Clay Tablet Connector for Oracle WebCenter Sites User Guide
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> O
T

L

26.1

-

e 52
At conditions: | 271

“' 'ﬂ*.New Ja

4.1 Adding Assets in the Translation Queue to Jobs

i Select the job name of a job that has not yet been sent out for translation. These are jobs that have

Created status.

i Select New Job, to create a new job for the selected assets.

3. Click Add to Job.

If you selected New Job in the job dropdown list, a pop-up window opens, prompting you to enter a

name for the new job. Enter the name and click OK.

A green message is displayed for a few seconds at the top of the page, stating the number of assets that were

added to the job.

The Job Details page opens, displaying information about the new or updated job. You use this page to
specify job settings, and you can also modify the assets in this job.
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4.1 Adding Assets in the Translation Queue to Jobs

Job Details  4»

Job 1D:

Job Name:

Description:

Status:

Created:
Last updatad:

PO Number:

Due Date (yyyy-mm-dd):

Translation Provider:

Send Meodified Fields Only:

Assets in this Job:
Pages: 1|2 ( 100 + | per page)
W Asset Type: 1D o
Content_C: 11140837399
Content_C : 11140837399,
Content_C : 11140837399
Content_C: 11140837390,
Content_C : 11140837399
Content_C : 11140837399
Content_C : 11140837399,
Content_C : 11140837390

43078736-9062-4d4b-bde2-nef84916818fd

LargeJobi

Created

fwadmin (2016-08-09 02:12:16)

2016-08-09 02:12:16

Total 183 Pending 183

Showing 1 to 100 of 183 total record(s), 0 selected.

T T G :

Source Updated Target

Asset Name
FSOFsEIntroducesDVDReC, = 5 2004-10-25 14:33:
FSOFSEIntroducesDVDRec.
FSOFSEIntroducesDVDRe: en_US 2004-10-25 14:33:
FSIFSEIntroducesDVDRec.

FSIFSEIntroducesDVDRec, 2004-10-25 14:33:

FSOFSEIntroducesDVDReC, en_US 2004-10-25 14:33:
FSIFSEIntroducesDVDRec. 2004-10-25 14:33:...
FETIFSEIntroducesDVDRe: en_US 2004-10-25 14:33:

2004-10-25 14:33:...

2004-10-25 14:33:...

004-10-25 14:33;

Delete Job

§

Last Updated Filter
2016-08-09 02:12:16 Ccurrent conditions:  none
2016-08-09 02:12:16 Aseat Name +
2016-08-09 02:12:16 Asset Type +

2016-08-09 18:42:20
Source Language +
2016-08-09 02:12:16
Target Language +
2016-08-09 02:12:16
Last Updated Date +
2016-08-09 18:42:20 .
Created User: fwradmi

_EREE

2016-D8-09 02:12:16

Any assets that are displayed in the list are part of the job and may be sent for translation.

4. Verify the assets in the job, and specify the following translation-job settings:

Field Description

Job ID The Connector's unique identifier for this job. Read-only.

Job Name The name of this translation job. You can modify this name.

Job The brief description of this translation job. You can modify this description.

Description

Status The status of this job, which is Created. For a list and description of translation-job
statuses, see page 47.
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Field

Description

Created

The username of the user who created the job, and the date and time when the job was
created, in the following format: YYYY-MM-DD hh:mm:ss. Read-only.

Last Updated

The date and time when the job was created, in the following format: YYYY-MM-DD
hh:mm: ss. Read-only.

PO Number The purchase-order ("PO") number for this job. Select the PO number from the dropdown
list. Depending on your site configuration, this field may be required, optional, or not
displayed at all. For more information, refer to the Clay Tablet Connector for Oracle
WebCenter Sites Installation and Configuration Guide.

Due Date The date when the translated asset is due, in the following format: YYYY-MM-DD.

Translation Select the translation provider from the dropdown list. If Freeway is selected, the

Provider following additional fields are displayed, where you can specify the analysis codes for the

translation:

B Region: The region relevant to the content. Your Lionbridge setup determines which
regions are displayed in the list.

B Department: The department relevant to the content. Your Lionbridge setup
determines which departments are displayed in the list.

B Priority: The priority of this job. Your Lionbridge setup determines which priorities are
displayed in the list.

Assets in this
Job

Note: For an existing job, both the new and the previous assets in the job are displayed.

The following information is displayed about the number of assets in this job:

B Total: The total number of assets in this job, including any assets that were previously
added to an existing job.

B Pending: The number of recently collected assets that can be added to this job.

B The number of assets displayed on this page of the asset list.

® The number of assets in the list with selected check boxes.

Clay Tablet Connector for Oracle WebCenter Sites User Guide Page 38

Version 1.1.7

December 14, 2017



4 Adding Assets to Translation Jobs 4.1 Adding Assets in the Translation Queue to Jobs

Field Description

Asset List The following information about the assets available to send out for translation:
Asset Type: The type of asset.
ID: OWCS's unique identifier for the asset.
Asset Name: The name of the asset, which was specified when the asset was created.
Source: The locale of the source language to send out for translation.
Tip: If you are viewing this page from the Contributor interface, you can click the link to
view the asset.
Source Updated: The date and time when the source asset was last updated, in the
following format: YYYY-MM-DD hh:mm:ss.
Note: You cannot sort by this column.
Target: The locale of the target language into which to translate the asset.
Tip: If the target asset already exists, you can click the link to view it.
Last Updated: The date and time when the target asset was last updated, in the
following format: YYYY-MM-DD hh:mm:ss.
Select the assets to send out for translation.
Important: The Connector will send out all the assets in the list for translation. To avoid
sending one or more assets for translation, select the corresponding check boxes, and
click Remove Selected to remove them from the list. A message box opens, confirming
that you want to remove the selected assets from the job. Click OK to proceed.
If there are more than 10 assets in the list, you can click the page number or change the

number of assets displayed in a page to view the other assets.
Use the following buttons to select and manage items in the list:

Select All: Selects all check boxes for the displayed assets.
Unselect All: Clears all selected check boxes for the displayed assets.
Remove Selected: Removes the assets with selected check boxes from the list.

Filter To display fewer assets in the list, in the Filter section in the bottom right corner, change
any filter settings and click Apply. This section is displayed only if there are 10 or more
assets in the list. For detailed instructions, see "Filtering Assets in a List" on page 29.

5. Do one of the following:

To save the job so that you can send it later, click Save Job. The Job Details page updates. The Status of
the Job is Created.

To send the job out for translation immediately, click Send Now. A message box opens, confirming that
you want to send out this job to the translation provider you specified earlier. Click OK to proceed. The
Status is Sending. Click View Details. The page updates. The Status is Sent to CT Platform. Inthe

asset list, the assets have SENDING TO PLATFORM status. Click the Refresh icon to refresh the
page.
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# To copy the assets in the job directly from the source locale to the target locale, without sending out the
job to the translation provider, click Copy Back. This is useful when there is content that you do not want
to translate, but that you want to include in the target version. A message box opens, confirming that you
want to copy over the assets without translating them. Click OK to proceed. This overwrites any
corresponding target assets that already exist. The status of the job is Sending to copy back. Click
View Details. The page updates. The status is now Completed (copied back).

Note: To copy assets from this job to a new or an existing job, in the Copy to dropdown list, either select the
name of a job that has not yet been sent out for translation, or select Create New Job, and then click
Copy to. For detailed instructions, see "Copying Assets Between Jobs" on page 44.

Note: To delete the job before saving or sending it, click Delete Job.

4.2 Modifying a Job before Sending It Out for Translation

If you have saved a job, then before you send it out for translation, you can make the following changes to it:
B You can add assets to the job.
B You can remove assets from the job.

B You can modify the settings of the job.

To modify a saved job:

1. Do one of the following:
# |n the Contributor interface, select Translation > Job Status from the menu.
# In the Clay Tablet Dashboard interface, under Management, click View All Jobs.

The Translation Jobs page opens. For a detailed description of this page, see "Monitoring All Translation
Jobs" on page 48.

2. Inthe Active Jobs section, click the link in the Name column for the job to modify.
Note: The job must have Created status, which indicates that it has not yet been sent out for translation.

The Job Details page opens.
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4.2 Modifying a Job before Sending It Out for Translation

Job Details  4#

All Translation Jobs
Job ID: a3b24f4f-03944924-b5ac-afc4ead3428b m
Job Name: Translation to German m
Created: fwadmin (2016-08-09 14:50:44)
Last updated: 2016-08-0% 14:50:44
PO Number: v

B Asset Type : ID

Page : 1124747609016

Due Date (yyyy-mm-dd):

Translation Provider:

Send Medified Fields Only:

Assets in this Job:

Total 5 Pending 5

Showing 5 total record(s), 0 selected.

Assel Name .

FalShoppingCart &

Source Updated

2005-08-22 18:13:

Targel

Last Updated

Page : 1118867611428 FSIlabout 2005-08-25 01:23:... de DE 2016-08-09 14:50:44 Filter only applies when there are more
Page : 1118867611408 FSIlArticles 2015-02-06 13:12; de_[ 2016-08-09 14:50:44 than 10 assets.

Page : 1123788908839 FSILogin en_US 2005-08-11 17:30: le_DE 2016-08-09 14:50:44

Page : 1124747609912 FSIProducts 2015-02-05 16:11:... de_DE 2016-08-09 14:50:44

2016-08-09 14:50:44

-

Filter

Any assets that are displayed in the list are part of the job and may be sent for translation.

3. Verify the assets in the job, and specify or update the following translation-job settings:

Field Description

Job ID The Connector's unique identifier for this job. Read-only.

Job Name The name of this translation job. You can modify this name.

Job The brief description of this translation job. You can modify this description.

Description

Status The status of this job, which is Created. For a list and description of translation-job
statuses, see page 47.

Created The username of the user who created the job, and the date and time when the job was
created, in the following format: YYYY-MM-DD hh:mm:ss. Read-only.
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Field Description

Last Updated | The date and time when the job was created, in the following format: YYYY-MM-DD
hh:mm: ss. Read-only.

PO Number The purchase-order ("P0O") number for this job. Select the PO number from the
dropdown list. Depending on your site configuration, this field may be required, optional,
or not displayed at all. For more information, refer to the Clay Tablet Connector for
Oracle WebCenter Sites Installation and Configuration Guide.

Due Date The date when the translated asset is due, in the following format: YYYY-MM-DD.

Translation Select the translation provider from the dropdown list. If Freeway is selected, the

Provider following additional fields are displayed, where you can specify the analysis codes for the
translation:

B Region: The region relevant to the content. Your Lionbridge setup determines which
regions are displayed in the list.

B Department: The department relevant to the content. Your Lionbridge setup
determines which departments are displayed in the list.

B Priority: The priority of this job. Your Lionbridge setup determines which priorities are
displayed in the list.

Assets in this | Note: For an existing job, both the new and the previous assets in the job are displayed.

Job The following information is displayed about the number of assets in this job:

B Total: The total number of assets in this job, including any assets that were previously
added to an existing job.

B Pending: The number of recently collected assets that can be added to this job.

B The number of assets displayed on this page of the asset list.

B The number of assets in the list with selected check boxes.
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Field Description
Asset List The following information about the assets available to send out for translation:
Asset Type: The type of asset.
ID: OWCS's unique identifier for the asset.
Asset Name: The name of the asset, which was specified when the asset was created.
Source: The locale of the source language to send out for translation.
Tip: If you are viewing this page from the Contributor interface, you can click the link to
view the asset.
Source Updated: The date and time when the source asset was last updated, in the
following format: YYYY-MM-DD hh:mm:ss.
Note: You cannot sort by this column.
Target: The locale of the target language into which to translate the asset.
Tip: If the target asset already exists, you can click the link to view it.
Last Updated: The date and time when the target asset was last updated, in the
following format: YYYY-MM-DD hh:mm:ss.
Select the assets to send out for translation.
Important: The Connector will send out all the assets in the list for translation. To avoid
sending one or more assets for translation, select the corresponding check boxes, and
click Remove Selected to remove them from the list. A message box opens, confirming
that you want to remove the selected assets from the job. Click OK to proceed.
If there are more than 10 assets in the list, you can click the page number or change the
number of assets displayed in a page to view the other assets.
Use the following buttons to select and manage items in the list:
Select All: Selects all check boxes for the displayed assets.
Unselect All: Clears all selected check boxes for the displayed assets.
Remove Selected: Removes the assets with selected check boxes from the list.
Filter To display fewer assets in the list, in the Filter section in the bottom right corner, change
any filter settings and click Apply. This section is displayed only if there are 10 or more
assets in the list. For detailed instructions, see "Filtering Assets in a List" on page 29.

4. Do one of the following:

To save the job so that you can send it later, click Save Job. The Job Details page updates. The Status of
the Job is Created.
To send the job out for translation immediately, click Send Now. A message box opens, confirming that
you want to send out this job to the translation provider you specified earlier. Click OK to proceed. The
Status is Sending. Click View Details. The page updates. The Status is Sent to CT Platform. Inthe
asset list, the assets have SENDING TO PLATFORM status. Click the Refresh icon to refresh the
page.
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# To copy the assets in the job directly from the source locale to the target locale, without sending out the
job to the translation provider, click Copy Back. This is useful when there is content that you do not want
to translate, but that you want to include in the target version. A message box opens, confirming that you
want to copy over the assets without translating them. Click OK to proceed. This overwrites any
corresponding target assets that already exist. The status of the job is Sending to copy back. Click
View Details. The page updates. The status is now Completed (copied back).

Note: To copy assets from this job to a new or an existing job, in the Copy to dropdown list, either select the
name of a job that has not yet been sent out for translation, or select Create New Job, and then click
Copy to. For detailed instructions, see "Copying Assets Between Jobs" on page 44.

Note: To delete the job, click Delete Job.

4.3 Copying Assets Between Jobs

You can copy assets from one job to another. This is useful if you send out one job for translation, and most of
the assets in the job are translated, but others are not, or they need updates. This feature facilitates copying
assets into a new job, without locating them first in the Site Tree or the Content Tree. You copy assets from one
job to another in the Job Details page.

To copy assets from one job to another:

1. Ifthe Job Details page is not already open:
a. Select Translation > Job Status from the menu to open the Translation Jobs page.

b. Inthe Name column, click the link for the job from which to copy assets.

For more information about the Translation Jobs page, see "Monitoring All Translation Jobs" on page 48.

The Job Details page opens.

2. Scrolldown to the asset list, at the bottom of the page.
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B Asset Type : ID o Assel Name Source Source Updated Target Status Last Updated Create New Job
Page : 1118867611408  FSIlArticles 2015-02-06 13:1 E EVIEW_TRA.. 2016-08-09 15:27:56 | Filter only applic
LargeJob2
Page : 1118667611428  FSIlAbout @ 2005-08-25 01:2 e_DE EVIEW_TF 2016-08-09 15:27:56 | than 10 assets. | | gregJlob3
Page : 1123788998839  FSIiLogin 2005-08-11 17:3 : EVIEW_TRA_. 2016-08-09 15:27:56 LargeJobi :
Translate to Spanish
Page : 1124747600912  FSTIProducts @ 2015-02-05 16:1 e_DE EVIEW_TF 2016-08-09 15:27:56 TestFreeway
Page : 1124747609916  FSIShoppingCart 2005-08-22 18:1 E EVIEW_TRA.. 2016-08-09 15:27:56

3. Select the check boxes for the assets to add to another job.

4. Inthedropdown list beside the Copy to button, do one of the following:

i Select the name of a job that has not yet been sent out for translation. These are jobs that have Created
status.

# Select Create New Job, to create a new job for the selected assets.
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5. Click Copy to. A message box opens, confirming that you want to copy the selected assets to the new or
specified translation job. Click OK to proceed.

6. Ifyou are creating a new job, a pop-up window opens, prompting you to enter a name for the new job.
Enter the name and click OK.

A message box opens, asking if you want to view the job to which you added the assets.

7. Do one of the following:
i Click OK to view this job.
i Click Cancel to view the previous job.
The Job Details page opens. You can send or save this job.

For more information about the Job Details page, see "Modifying a Job before Sending It Out
for Translation" on page 40.
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5 Sending Out Jobs for Translation

Whenever you send out a job for translation, you send it out from the Job Details page.

The Job Details page opens automatically in the following scenarios:

B You collect a single asset to send out for translation, and you add it to a new or an existing job. For details,
see "Collecting One Asset for Translation" on page 17.

B You collect multiple assets to send out for translation, and you add them to a new or an existing job. For
details, see "Collecting Multiple Assets for Translation" on page 23.

B |nthe Translation Queue, you add one or more queued assets to a new or an existing job. For details, see
"Adding Assets in the Translation Queue to Jobs" on page 33.

In these scenarios, you can either immediately send out the job for translation, or you can save it, so that you
can send it out later.

To send out a previously saved job for translation:

1. Do one of the following:
In the Contributor interface, select Translation > Job Status from the menu.
In the Clay Tablet Dashboard interface, under Management, click View All Jobs.

The Translation Jobs page opens. For a detailed description of this page, see "Monitoring All Translation
Jobs" on page 48.

2. Inthe Active Jobs section, click the link in the Name column for the job to modify.
Note: The job must have Created status, which indicates that it has not yet been sent out for translation.

The Job Details page opens.

3. Optional. Add or remove assets in the job, and specify or update the translation-job settings. For a detailed
description of this page and these settings, see "Modifying a Job before Sending It Out for Translation" on
page 40.

4. Click Send Now.

A message box opens, confirming that you want to send out this job to the specified translation provider.
Click OK to proceed.

The Job Details page refreshes.

5. To view the translation progress of this job, click View Details.

The page updates.

6. TheStatusis Sent to CT Platform. Intheasset list, the assets have SENDING TO PLATFORM status.

Click the Refresh icon to refresh the page.
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6 Monitoring the Translation Status of Assets and Jobs

After you send out a job for translation, you can monitor its progress:

B You monitor the translation status of multiple jobs in the Translation Jobs page. For details, see "Monitoring

All Translation Jobs" on page 48.

B You monitor the translation status of a single job and the assets within that job in the Job Details page.

Note: If you configure the translation job to put the target asset into a workflow state, then you can configure
the workflow steps to send out email alerts when the asset returns from translation. For more information,

refer to the appropriate version of the OWCS documentation at
http://www.oracle.com/technetwork/middleware/webcenter/sites/documentation/index.html.

B Forinformation on using a workflow, see "Using Workflow to Manage the Translation Process" on page 63.

B Forinformation on configuring a workflow, refer to the Clay Tablet Connector for Oracle WebCenter Sites
Installation and Configuration Guide.

6.1 Translation Statuses

Translation jobs and assets can have the following statuses:

Correspondin
Job Status | Job Status Description P & Asset Status Description
Asset Status
Created The Connector created the job. PENDING The Connector added the assets
toajob.
Sending The Connector is sending the job to the
Clay Tablet Platform for forwarding to
the translation provider.
Sent to The Connector sent the job to the Clay | SENT TO__ The Connector sent the assets to
CT Platform | Tablet Platform for forwarding to the PLATFORM the Clay Tablet Platform for
translation provider. forwarding to the translation
provider.
SENT TO_ The Clay Tablet Platform sent the
TRANSLATOR assets to the translation provider.
Sending to | The Connector is preparing to copy the | PENDING The Connector is copying the
copy back assets in the job from the source locale asset from the source locale to
to the target locale, without sending the target locale.
them out for translation.
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Job Status | Job Status Description Corresponding Asset Status Description
Asset Status
Completed | The Connector has finished copyingthe | COMPLETED_ | The Connector copied the asset
(copied assets in the job from the source locale | COPIED_BACK | from the source locale to the
back) to the target locale. target locale.
In The translation provider has received IN_ The translation provider has
translation | the job for translation and has not yet TRANSLATION | received the assets for translation
returned the translated assets. and has not yet returned the
translated assets.
Reviewing | The Connector received the translated REVIEW _ The Connector received the
Translation | assets in the job back from the TRANSLATION | translated assets back from the
translation provider. The translated translation provider. The
assets are ready for review in the translated assets are ready for
Connector. review in the Connector.
Completed | AConnector user reviewed and COMPLETED A Connector user reviewed and
(translation | approved the translated assets in the approved the translated assets in
approved) | Connector. The Connector moved the the Connector. The Connector
translated assets to OWCS. moved the translated assets to
Note: The job has this status only when OWCS.
allits assets have COMPLETED status.

6.2 Monitoring All Translation Jobs

You can monitor the status of all translation jobs on a single page, from either the Contributor interface or the
Clay Tablet Dashboard interface.

To view the status of all translation jobs:

1. To open the Translation Jobs page, do one of the following:

# In the Contributor interface, select Translation > Job Status from the menu.

i |n the Clay Tablet Dashboard interface, under Management, click View All Jobs.

The Translation Jobs page opens. The page is displayed slightly differently, depending on how you open it:

# This page in the Contributor interface:
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Translation Jobs %

| Status # of Assets
B 1st test 1

B orade Dema First demo job Completed (transl 2

B orace second demo job Comp (transl... 31

B 15t 13.1 Completed (transl.. 15

Select All Unselect ANl

Due Date

2015-01-20

Active Jobs:  Showing 1 to 10 of 12 total record(s)
Pages: 1|2 (10 = perpage)
Name scription # Provider Updated ~ Submitte
1 2015-02-19
Created 3 2015-02-19
test2 2nd test Reviewing transia... 1 1998-11-30 Machine Tr 2015-02-19 2015-02-19
26.1 26.1 In trans 20 Machine Tr. 2015-02-18 2015-02-18
. cated 1 Machine Tr.. 2015-02-17
10 Machine Tr_  2015-02-13  2015-02-13
5.2 5.2 o 2015-02-05
28.1.2 28.1.2 6 Machine Tr.. 2015-01-28 2015-01-28
28.1 28.1.1 Reviewing transa... B Machine Tr.. 2015-01-28 2015-01-28
27.1.2 27.1.2 In translation 6 Machine Tr. 2015-01-27 2015-01-27
Inactive Jobs:  Showing 4 total record(s) , 0 selected

Archive Selected

Provider Updated » Submitted
Machine Tr.. 2015-02-19  2015-02-1%
Freaway 2015-02-18 2015-01-08
Freaway 2015-02-18  2015-01-08
Machine Tr 2015-01-27  2015-01-27

Archived Jobs:  there are 2 archived jobs. Show archived jobs

Loading archived jobs ...

This page in the Clay Tablet Dashboard interface:

Translation Jobs %

Active Jobs:  Showing 1 to 10 of 12 total record(s)

Pages: 1|2 (10 ~ perpage)

# of Assets Due Date

5

2nd test 1 1098-11-30
26.1 26.1 In transktion 20
17.2 1
12.2 10
5.2 5.2 [t}
28.1.2 28.1.2 G
28.1.1 Reviewing translation 8
27.1.2 27.1.2 In transktion 6

Provider

Machine Tra

Machine Tra...
Machine Tra...
Machine Tra...

Machine Tra
Machine Tra
Machine Tra...

Siteld

FirstSitall
FirstSitell
FirstSitell
FirstSitell
FirstSitell
FirstSitall
FirstSitell
FirstSitell
FirstSitell
FirstSitell

fiwadmin
fwadmin
fwadmin
fwadmin
fwadmin
fwadmin
fwadmin
fwadmin
fwadmin
fwadmin

Updated ~
2015-02-19
2015-02-19
2015-02-19
2015-02-18
2015-02-17
2015-02-13
2015-02-05
2015-01-28
2015-01-28
2015-01-27

Submitted

201502-19
2015-02-18

2015-02-13

2015-01-28

2015-01-28
2015-01-27

Showing 4 total record(s) , 0 selected

Selact All Unselect All Archive Selected

Description Status # of Assets Due Date Provider Siteld Created Updated »  Submitted

(= 1st test 1 Machine Tra... FirstSitell fewadmin 2015-02-19  2015-02-19

[ First demo job Completed (transh 2 2015-01-30 Freeway FirstSitell fwadmin 2015-02-18 2015-01-08

[ second demo job 31 Freeway FirstSitell fwadmin 2015-02-18 2015-01-08

B 13 1st13.1 Completed (transia 15 Machine Tra FirstSitell fwadmin 2015-01-27 2015-01-27

Archived Jobs:  there are 2 archived jobs. Show archived jobs

Loading archived jobs ...
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In both versions of this page, the jobs are divided into two lists:

# The Active Jobs list has translation jobs that have not yet been completed. For example, if you have not
yet approved the translation of assets in a job, then the job is incomplete.

# The Inactive Jobs list has translation jobs that have been completed, including the final step, which is
approval of the translation. For example, if you have approved the translation of all the assets in a job,
then the job is complete.

Tip: To update your view of the jobs and statuses, click Refresh in the top-left corner of the page.

Note for administrators: If you are assigned either to the CTSiteAdmin role for multiple sites or to the
CTAdmin role, and you open this page from the Clay Tablet Dashboard interface, then you can use the Site
dropdown list in the top right corner of the page to select which site's jobs to view.

The translation jobs are displayed in reverse chronological order by the date that they were last updated.
¥ To reverse the sort order, click the Updated column heading.

The following information is displayed about each translation job in the list:

Column Description

Name The name of the translation job.

Description | The description of the translation job.

Status The status of the translation job. For a list and description of all statuses, see "Translation
Statuses" on page 47.

#of Assets | The number of assets in the translation job.

Due Date The due date of the translation job, if one was specified, in the following format: YYYYy-MM-
DD.

Provider The translation provider for the translation job.

Site ID The OWCS site where the assets in the translation job are located. Displayed only in the Clay

Tablet Dashboard interface.

Created The username of the user who created the translation job. Displayed only in the Clay Tablet
Dashboard interface.

Updated The date the translation job was last updated, in the following format: YYYY-MM-DD.

Submitted | The date the translation job was submitted to the translation provider for translation, in
the following format: YYYY-MM-DD.

2. You can perform the following actions on this page:

F To view the status of the assets in a translation job, click the link in the Status column.
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The row expands, and it displays the number of assets with each status in the job.

Fme ."'-"” ."'--", — s Tt .
AV g TrETaEt Lo eme Ve Ti-e Aachiiie « Firstsifall A

oy

find

1 ; Machine Tra... FirstSitell
= Lf:bbe_-?'l—"ll transht |u Reviey -.nc_. LI:II::LIJI@ Completed (nothing to transkt

R e -d e .. 4l T Wl

¥ To view translation-job details, click the link in the Name column.

Note: To approve the translation of assets in a job, you must first view the job details. For more
information, see "Approving Translated Assets" on page 57.

¥ To archive one or more inactive jobs, select the corresponding check boxes in the Inactive Jobs list, and
then click Archive Selected. Available only in the Clay Tablet Dashboard interface.

Note: You can archive active jobs individually in the Job Details page, although it is not recommended. If
you archive an active job, it will no longer be displayed iin the Active Jobs list. Archiving a job also
archives the assets in that job: If you archive content while it is being translated, then the Connector will
not return the completed translation to you. For more information about archiving jobs, see page 59.

k' To view any previously archived jobs, click the Show archived jobs link. Available only if there are
previously archived jobs, and available only in the Clay Tablet Dashboard interface.

The Translation Jobs page refreshes, and it displays the Archived Jobs section at the bottom of the page.

e - - P T o iees . e

P ,_.-\,L‘_ SIS e e A e E B T e e
Archived Jobs: Showing 2 total record(s) , 0 selected Hide archived jobs
-—
Status # of Assets  Due Date Provider Siteld Created Updated = Submitted
This & the second job sent from Tech d D t t 6 Freeway FrstSitell fwadmin 2015-01-08 2015-01-06
This is the first job sent from Tech docs. £ ansis 6 Freaway FrstSitell fwadmin 2015-01-06 2015-01-06

The same information is displayed about all the archived jobs. In this section, you can also:
Hide all archived jobs by clicking the Hide archived jobs link.

Unarchive jobs, by selecting the corresponding check boxes and clicking Unarchive Selected.

6.3 Monitoring Assets in a Single Translation Job

When you send out a translation job, it is always from the Job Details page. After you send out a job, the job
status, which is displayed in the Status field, changes from Createdto Sending.

To monitor the translation progress of the jobs and the assets in the job:

1. After sending out a job for translation, in the Job Details page, click View Details.

The Job Details page expands.
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Job Details ¢ All Translation Jobs

Job ID: 51125096-28ee-4che-2204-19dde1 beBebe
Job Name: Translate to Spanish
Description:
Status: Sent ta CT Platform
Created: fwadmin (2016-08-09 15:31:29)
Submitted by: fwadmin (2016-08-08 17:44:41)
Last updated: 2016-08-09 17:44:41
PO Number:

Due Date (yyyy-mm-dd):
Assets in this Job: Total 6 Sent to CT Platform 6

Showing 6 total recond(s), 0 selected.

-

Assel Type : ID o Assel Name Last Updated Filter
Page : 1118867611408  FSIAticles en_US 2015402406 13:1.  es_ES SENT_TO_PL.. 2016-08-09 17:44:41 | Filter anly applies when there are mare
Page : 1118867611428  FSIAbout en_LU 2005-08-25 01:2.. s E SEN PL.. 2016-08-09 17:44:41 | than 10 assets.

Page : 1123788998839  FsILogin en_Us 2005408-11 17:3.. &5 ES SENT_TO_PL.. 2016-08-09 17:44:41

Page : 1124747609912 FSIProducts en_US 2015-02-05 16:1..  es5_ES SENT_TO_PL... 2016-08-09 17:44:41

Page : 1124747609916 FaIlShoppingCart en_LUs 2005-08-22 18:1.. &5 ES SENT_TO_PL 2016-05-09 17:44:41

Page : 1351276311107  FollAmicles fr_FR 2015402-09 20:5.. o5 [ES SENT_TO_PL.. 2016-08-09 17:44:41

The Status is Sent to CT Platform. Inthe assetlist, the assets have SENDING TO PLATFORM status.

2. Click the Refresh icon to refresh the page and watch the statuses change.
The Status field displays the job status.
In the asset list, the Status column displays the asset status.

For a list and description of all job and asset statuses, see "Translation Statuses" on page 47.

3. Optional. If the asset status is Review Translationor Completed, click the corresponding link in the
Status column in the asset list.

The Translation request detail window opens.
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Translation request detail

Source Asset: FsllAbout (Page : 1118867611428)
Target Asset: FSllAbout{"Page : 1351276304403")
Source Locale: en_LS

Target Locale: de_DE

Status: COMPLETED

CT Support information

Job Id: 3326653b-958d-42c5-b4de-fecocn38585h
Asset Id: e1060518-b1bb-4229-87c1-cf1f9dd42d4c
Asset Task Id: Daccf36c-6e32-4dff-9465-0322054 702af
Job Provider Ref :

Asset Provider Ref : 21050518-b1bb=4229-87C1-F19dd4 204 ¢

f:-".'}t‘

This window displays the following information about the translated asset, which is useful for
troubleshooting:

Field Description

Source The name of the source asset, which was specified when the asset was created, and OWCS's

Asset identifier for this asset.

Target The name of the target (translated) asset, which is the same as the name of the source asset,

Asset and OWCS's identifier for this asset.

Source The locale of the language of the source asset, which was sent out for translation.

Locale

Target The locale of the language of the target asset, which is the translated asset.

Locale

Status The status of the asset. For a list and description of these statuses, see "Translation Statuses"
on page 47.

Job ID The Connector's unique identifier for this job.

Asset ID | The Connector's unique identifier for this asset.
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Field Description

Asset The Connector's unique identifier for this asset task. Asset tasks are either assets (source
Task ID | content for translation) or target-specific translation tasks for translating a particular content
item (asset). The task of translating a particular asset (content item) into a single language is a
single asset task. Therefore suppose a content item will be translated into both French and
German. The asset is the content item in the source language. There are three asset tasks: the
original content item; the translation of the content item into French; and the translation of
the content item into German.

Job The translation provider's reference for this job, if it is available.
Provider
Ref.

Asset The translation provider's reference for this asset, if it is available.
Provider
Ref.

4. Click Close to close the window.

For a detailed description of the other fields and columns in the Job Details page, see "Modifying a Job before
Sending It Out for Translation" on page 40.

6.4 Checking an Asset's Translation Status

When an asset is open in OWCS, you can check its translation status. This means you can see the status of the
asset in all the relevant locales.

To check an asset's translation status:

1. Inthe Site Tree or the Content Tree, double-click an asset to open it.

2. Select Translation > Asset Translation Status from the menu.

The Translation Status page opens.
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Translation Status: FSITArtides %

This screen displays the status of all transiation reguests from or to the curent asset.

Waiting approval: Approve Selected

a Job Mame Job Status Job Submitted Provider Target Updated
[ Reviewing transktion 2015-01-27 Machine Transition es_ES de_Di 2015-01-27 Reviewing transiation

] Job Name Job Status Job Submitted Provider Target Updated Status
B 26.1 Created es_ES hu_HU 2015-02-09 Pending
26.1 Created es_ES en_US 2015-02-09 Panding

H JobName Job Status Job Submitted Provider Source Target Updated Status
13.1 Completed (transiztion approved)  2015-01-27 Machine Transition en LS es ES 2015-01-27 Completed (transiation approved)

This page displays information about all translation requests relevant to this asset. It is organized into the
following sections:

Waiting for approval: Displays assets that were received back from translation, but which have not yet
been approved. These assets have Reviewing translation status.

Active: Displays assets that have not yet been sent out for translation. These assets have Reviewing
translation status.

Inactive: Displays assets that were received back from translation, and which were already approved.
These assets have Completed (translation approved) status.

If there are no translation requests relevant to a section, then a message to that effect is displayed instead.

This page displays the following information about each asset:

Column Description

Job Name The name of this translation job.

Job Status The status of this job. For a list and description of job statuses, see "Translation Statuses"
on page 47.

Job The date the job was submitted, in the following format: YYYY-MM-DD. Not relevant for

Submitted active jobs, which have not yet been submitted for translation.

Provider The name of the translation provider. May not be relevant for active jobs, which have not
yet been submitted for translation.

Source The locale of the source language. For an inactive job, you can click the link to view the
source asset.
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Column Description

Target The locale of the target language. For a job waiting for approval or for an inactive job, you
can click the link to view the target asset.

Updated The date the job was last updated, in the following format: YYYY-MM-DD.

Status The status of assets in this job. For a list and description of asset statuses, see
"Translation Statuses" on page 47.

3. Optional. To view more information about the job, including the list of assets in the job, click the link in the
Job Name column. The Job Details page opens, as described in "Modifying a Job before Sending It Out
for Translation" on page 40.

4, Optional. To approve translated jobs, select the corresponding check boxes in the Waiting for approval
section, and click Approve Selected. The status of the selected jobs changes to Completed

(translation approved).
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7 Post-Translation Tasks

After assets return from translation, you can complete the following tasks:

B "Approving Translated Assets" on page 57.

This task is required to change the status of the job to Completed (translation approved), andthe
status of the translated assets to Completed.

B "Archiving Jobs" on page 59.

This task is optional, but it is recommended. Typically, you archive a completed job so that it will not be
displayed anymore in the Inactive Jobs section of the Translation Jobs page. You can archive jobs both from
the Contributor interface and the Clay Tablet Dashboard interface.

Note: You cannot delete a completed job.

B "Viewing Translated Assets" on page 61.

This task is optional. You can see a list of all the translated versions of this asset.

7.1 Approving Translated Assets

After a job returns from translation, it has the following status: Reviewing Translation. The translated
assets within that job have the following status: REVIEW TRANSLATION.

You must approve the translations before they return to OWCS, so that they will be ready for publishing to a
website.

Note: Approving translated assets is not related to the CT: Approve TranslationstepintheCT:
Approval for Content workflow process.

You can approve translated assets from either the Contributor interface or the Clay Tablet Dashboard interface:
B |n the Contributor interface, you can click links to see the source and target versions.

B Inthe Clay Tablet Dashboard interface, you cannot see the source and target versions.

To approve translated assets:

1. Do one of the following:
# |n the Contributor interface, select Translation > Job Status from the menu.
# In the Clay Tablet Dashboard interface, under Management, click View All Jobs.
The Translation Jobs page opens. For a detailed description of this page, see "Monitoring All Translation
Jobs" on page 48.
2. Toview a list of assets in the translated job, click the link in the Name column for the job.

The Job Details page opens. This page displays differently, depending on whether you open it from the
Contributor interface or from the Clay Tablet Dashboard interface.
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Important: If you open this page from the Clay Tablet Dashboard interface, then there are no links in the
Source or the Target column.

3. Optional. Review the translated asset. Available only if you are viewing this page from the Contributor
interface.

a. InthelJob Details page, click the corresponding link in the Target column in the asset list at the bottom of
the page.
The translated asset opens in a new tab.

b. Review the translation.

c. When you are done, click the Translation Jobs tab to return to the Job Details page.

4. Click the link for the job, to reopen the Job Details page.

Job Details ¢ A

Job ID: 511e5096-28ee-4che-a294-19ddel bedebe
Job MName: Translate to Spanish
Description:

Status: Reviewing translation

Created: fwadmin (2016-08-09 15:31:29)

Submitted by: fwadmin (2016-08-09 17:44:41)
Last updated: 2016-D8-09 17:46:58

Assets in this Job: Total &  Reviewing translation &

Showing 6 total record(s), 0 selected.

-

B Asset Type:ID . Asset Name Source Source Updated Target Status Last Updated Filter
E 2016-08-09 17:46:57

2015-02-06 13:1.

Page: 1118867611408  FSIlAticles

Filter only applies when there are more

Page: 1118867611428  FS[Abowt en_L 2005-08-25 01:2.. es_E° EVIEW_TRA . 2016-08-09 17:46:57 | than 10 assets.
Page: 11237BB998639  FSILogin en_LIS 2005-408-11 17:3.. es ES 2016-08-09 17:46:57
Page : 1124747609912  FSIProducts en_LS 2015-02-05 16:1.. es_ES REVIEW TRA.. 2016-08-09 17:46:57
Page : 1124747609916 FSIIShoppingCart en_L 2005-08-22 18:1.. =5 E EVIEW_TRA... 2016-08-09 17:45:56
Page : 1351276311107  FSIAmticles fr_FR 2015402-09 20:5.. es_ES REVIEW_TRA.. 2016-08-09 17:46:56

5. Inthe asset list at the bottom of the page, select the check boxes for the assets you want to approve.

6. Click Approve Selected.

A message box opens, confirming your approval.

7. Click OK to proceed.
The status of each approved asset changes to COMPLETED.

8. After you approve all assets in a job, click the Refresh icon at the top of the page.

The job's status changes to Completed (translation approved).
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7.2 Archiving Jobs

You archive a translation job so that it will no longer be displayed in the Connector interfaces, specifically, the
Clay Tablet Dashboard interface, and the Contributor interface.

Typically, you archive a translation job after all its assets have been translated and approved, when it is inactive,
which means it has either the Completed (translation approved) or Completed (copied back)
status. However, in the Clay Tablet Dashboard interface, you can also archive a job when it has other statuses.
You can archive jobs as follows:

B |n the Contributor interface, you can archive individual inactive jobs by clicking the Archive Job button in the

Job Details page.

Job Details %
JobID:  7d02d4b7-2616-4239-ba66-91 dd4d69590F
Job Name: 13.1
Description: 1st 13.1
Status: Completed (transbtion approved) )
Created: fwadmin (2015-01-13 19:49:37)
R . '&W ﬂM ™ Wit M‘w\ "*xi—‘r
b, . ..
S FI P S A _e""'-._’_,_,_. P e — — e P /"' LT .-'._ Y.
R sndwing 2 fital recoTay sy 0 Selectéd. R T e P Eama
T TS e i
B Asset Type: 1D o Asset Name Source Source Updated Target Status Last Updated Filter
Page : 1118867611428 FsIlabout 2005-08-25 01:2. 2016-08-09 02:02:41 Filter only applies when there are more
Page @ 1118867611428  FSIAbout en_LI 2005-08-25 01:2. 2016-08-09 02:02:41 | than 10 assets.

This button is displayed only if the job status is either Completed (translation approved) or
Completed (copied back), and if the status of all the assets in the job is Completed.

E |n the Clay Tablet Dashboard interface:

# You can archive multiple inactive jobs from the Inactive Jobs section of the Translation Jobs page.
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7.2 Archiving Jobs

Translation Jobs %

1.1
27.1.2

Machine Tr

T ‘ t f12 t

2015-01-27

Archive Selacted '

2015-01-27

Loading archived jobs ...

Status # of Assets Due Date Provider Updated » Submitted
[ 1st test C 1 Machine Tr.. 2015-02-1% 2015-02-19
[ acke Der First demao job Completed (trans 2 2015-01-30 Freeway 2015-402-18 2015-01-08
B o d 5 il second demo job Completed (transl.. | 31 Freeway 2015-02-18  2015-01-08
B 1st13.1 Completed (trans 15 Machine Tr 201501-27 2015-01-27
Archived Jobs:  there are 2 archived jobs. Show archived jobs

For a detailed description of this page, see "Monitoring All Translation Jobs" on page 48.

You can archive individual active or inactive jobs with the In translation, Reviewing

translation, or Completed status, by clicking the Archive Job button in the Job Details page.

Job Details {4

Site:

Job 1D:

Job Mame:

Description:

Created:
Submitted by:
Last updated:

PO Number:

Due Date (yyyy-mm-dd):

Translation Provider:

Send Modified Fields Only:

Assets in this Job:

Asset Type : ID o

Asset Name

FirstSitall

511e5006-28ee-4cbe-3204-10ddelbeBebe

Translate to Spanish

feradmin (2016-08-09 15:31:29)
fwadmin (2016-08-09 17:44:41)
2016-08-00 17:46:58

MT Ls#

false

Total 6 Reviewing branslation &

Showing 6 total record(s), 0 selected

Source Updated Target

Page : 1118867611408 FSllArticles en_us 2015402-06 13:12:00  es_ES
Page : 1118867611428 F5IAbout en_Us 2005-08-25 01:23:12  es_ES
Page : 1123788998839 FSIILogin en_uUs 2005408-11 17:39:24  es_ES
Fage : 1124747609912 FsIIProducts en_Us 2015-02-05 16:11:26  es_ES
Page : 1124747609916 FsIShoppingCart en_Us 2005-08-22 18:13:18 &5 ES
Page : 1351276311107 FSIlAticles fr_FR. 2015-02-09 20:54:10  es_ES

fwradmin
foradmin
fwadmin
Fwadmin
Fesadmin

Fwadmin

2016-08-09 17:46:57
2016-08-09 17:46:57
2016-08-09 17:46:57
2016-08-09 17:46:57
2016-08-09 17:46:56

2016-08-09 17:46:56

All Translation Jobs

'

Filter

Filter only applies when there are more
than 10 asssts.

Note: The Archive Jobs button is not displayed when a job has the Created status. However, you can
delete a job with this status by clicking the Delete Job button.
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7.3 Viewing Translated Assets

Note: You can unarchive an archived job by clicking the Unarchive Job button when viewing the job in

the Job Details page.

Warning: Archiving active jobs is not recommended. If you archive an active job, it will no longer be
displayed in the Active Jobs list. Archiving a job also archives the assets in that job: If you archive content
while it is being translated, then the Connector will not return the completed translation to you.

The following table summarizes job statuses and corresponding job activity and archiving information:

approved)

Note: The job has this status
only when all its assets have
COMPLETED status.

Job Status Active/Inactive Jobs | Archiving Information
Created active cannot be archived
Sending active can be archived only from the Clay Tablet Dashboard
interface, individually, from the Job Details page
Sent to CT Platform active
In translation active
Reviewing Translation active
Completed (copied back) inactive can be archived in any of the following ways:
B from the Clay Tablet Dashboard interface, from the
Completed (translation inactive

Translation Jobs page

B from the Clay Tablet Dashboard interface,
individually, from the Job Details page

B from the Contributor interface, individually, from
the Job Details page

7.3 Viewing Translated Assets

When an asset is open in OWCS, you can view its translated assets. This means you can see a list of all the

translated versions of this asset.

To view the translations of an asset:

1. Inthe Site Tree or the Content Tree, double-click an asset to open it.

2. Select Translation > View Translations from the menu.

The Translation for page opens.
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Translation for: FSI1Artices %

Type Id Locale Asset Name

Pagea 1421358949327 hu_HU Transiztion of (hu_HU) FSIlArtides_42703..
Page 1351276305527 e5_ES FSITArticles

Page 1351276304149 fr_FR. FSITArticles

Page 1421358950159 de_DE

It displays the following information about all the translated versions of this asset:

Column Description

Type The type of asset.

ID OWCS's unique identifier for the asset.

Locale The locale of this translation of the asset.

Asset Name The name of the asset, which was specified when the asset was created.

3. Optional. In the Asset Name column, you can click the link to open the Translation Status page for this
asset, where you can view the status of the asset in all the relevant locales. For details, see "Checking an
Asset's Translation Status" on page 54.
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8 Using Workflow to Manage the Translation Process

Most websites are produced by a team of people in which different individuals assemble content, edit and
review it, and decide what goes where and when to update the pages. Work flows from one person to the next
in a predictable way, and that process in OWCS is called workflow. In OWCS, assets can be assigned to a
workflow. This transfers permissions for these assets to a particular user, so that these assets are displayed in
the user's Assignments list on the Home tab of the dashboard of the Contributor interface.

If properly configured, you can usethe CT: Approval for Content workflow with the Connector to
manage your translations. To use the workflow with the Connector, you put assets in the workflow in the
Contributor interface. Using the workflow with the Connector has the following advantages:

B When assets come back from translation, they are in a new workflow state. Your company may have
configured OWCS to send out email notifications when assets change state. This is helpful to the people who
review translated assets before publication.

B You may receive email notifications when an asset is translated or assigned to you.

B Your company may have extended and integrated the final step ofthe CT: Approval for Content
workflow with other workflows. For example, this workflow may be configured so that the asset is assigned
to an additional person for review and approval before publication, for example, a legal review.

B You may be able to assign due dates to assets.

B You may be able to delegate your assignments to other people.

What is the Connector's support for workflow?
When the CT: Approval for Content workflow process is properly configured in OWCS, you can select it
when you collect assets for translation.

If you select this workflow:

B When you send out assets for translation, you specify the workflow process, and the target OWCS asset is
inserted into the workflow in the CT: Pending Translation state.

B When the translated asset returns from translation, the OWCS asset automatically advances to the CT:
Translated, Pending Approval state.

B When you resend the asset for translation, it reverts to the CT: Pending Translation state.

TheCT: Approval for Content workflow has the following states and steps:

Workflow State Description

CT: Pending Translation An asset is in this state when you add it to the workflow process, before it is
translated.

CT: Translated, Pending An asset is in this state after it is translated, and before the translation is

Approval approved.
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The order in which the assets move between states is defined in the workflow process by the following four
steps. Astep is the action of moving the asset from one state to the next.

Workflow _—
Description
Step
CT: Send This step moves assets into the workflow in the CT: Pending Translation state, where
for they have not been translated.
Translation
CT: Send This step moves assets from the CT: Pending Translation state, where they have not
for been translated, into the CT: Translated, Pending Approval state, where the assets
Approval have been translated, but they have not yet been reviewed.
CT: This step moves assets from the CT: Translated, Pending Approval state, where they
Approve have not been translated but not yet reviewed, out of the workflow. If your company has an
Translation | existing workflow, instead of moving assets out of the translation workflow, you can add
custom steps to include that workflow. For example, you can add another step to the workflow
to require legal approval of content.
Note: This workflow step is not related to approving translations in the Contributor interface.
CT: Resend | This step sends assets that have already been translated back to translation. This step ois
for useful if the translation is not satisfactory or if many changes are required.
Translation

In order for the workflow process to work as described above, it must be configured. For detailed configuration
instructions, refer to the Clay Tablet Connector for Oracle WebCenter Sites Installation and Configuration

Guide.

How to use workflow with the Connector

When the workflow is integrated with the Connector, you perform the following major tasks to manage your

translations:

Note: The instructions below are correct for either a single asset or multiple assets.

1. When you collect assets for translation, you assign them to the "Assigning Collected Assets to a Translation
Workflow" on page 65.

2. Optional. You can view the workflow status of an asset anytime after you add the asset to the workflow.

For information on viewing the status of a single asset, see page 65.

For information on viewing the status of multiple assets, see page 66.

3. Optional. When you collected assets, in step 1 above, you may have added them to a translation job.
Otherwise, if you added the collected assets to the Translation Queue, you must add them to a job before
sending them out for translation. For details, see "Adding Assets to Translation Jobs" on page 33.
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4. You send out the job containing the assets for translation, as described in "Sending Out Jobs for
Translation" on page 46.

5. After the assets return from translation, you can review them and move them out of the workflow, orto a
custom state of the workflow that your company has configured. For details, see "Reviewing Translated
Content" on page 67.

8.1 Assigning Collected Assets to a Translation Workflow

When you collect assets for translation, you can assign them to the CT: Approval for Content workflow
process.

To add one or more collected assets to the translation workflow process:

1. Collect one or more assets for translation, as described in "Collecting One Asset for Translation" on page 17
or "Collecting Multiple Assets for Translation" on page 23.

2. Inthe Select Target Workflow dropdown list, select the CT: Approval for Content workflow.

e

- LA . - :
A S s —_—— e PR - —

N s

(Select Target Workflow: ) Do NotAddto Workflow |

Do Mot Add to Workflow

F5Il: Approval for Content

F3ll: Approval for Products

FSll: Approval for Arwork

Send with Dependencies: FSI: Approval for Promotions

F3l Approval for Structure
O

Add To Job/Queue:

LM Ap:}walh}cn;&el;’; =

This assigns the assets to the workflow.

3. Continue collecting the assets to send for translation, as described in the relevant sections of this guide.

Important: After you assigns assets to the CT: Approval for Content workflow, you must still add
them to a new or an existing job, and then send them out for translation from the Job Details page. As an
intermediate step, you can add assets to the Translation Queue before adding them to a job.

8.2 Viewing the Workflow Status of One Asset

After you assign an asset tothe CT: Approval for Content workflow, you can select View > Status to see
its workflow status.

Note: This is standard OWCS functionality.
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To view the workflow of a single asset:
1. Ensurethat the assetis open in OWCS in the active tab.

2. Select View > Status from the menu.

The Content page for the asset opens.

3. Scrolldown to the Workflow process field.

-~ et - - pem e f e,

e e A o= - _\ . - E ¢ 3 . - —
e N L L N s

Workflow commands: =Select Workflow Action>

Workflow process: @: Approval for Content - CT: Pending Trar'sl.a’.ll:l":)

Workflow state: Assigned to  Assigned by  Assigned date Action to Take Step Chosen

favadsrin feradmin 3/20/15 11:14 AM  Assignment information not available

Task Status

active

8.3 Viewing the Workflow Status of Multiple Assets

Workflow history:

This field displays both the name of the workflow process, CT: Approval for Content, and the
workflow state, CT: Pending Translation.

The workflow state in the screen capture above indicates that the asset has not yet been sent out for

translation.

SO W TP R SRR NP L Y SN

8.3 Viewing the Workflow Status of Multiple Assets

After you assign assets to the CT: Approval for Content workflow, they are displayed in your
Assignments list on the Home tab of the dashboard of the Contributor interface.

Note: This is standard OWCS functionality.

The following screen capture displays assets that were sent to translation, so the Action to Take is to wait for

the assets to return from translation.
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] Assignments (7) # 0
Asset Name & Action to Take Aszsigned by Due (Days)
FSllFrmsTakeStep Vait for Clay Tablet to transkats Twadmin
FElFirmsTakeStep Wail for Clay Tablet to iransiale T admin
FSliFrmsTakeSiep Vait for Clay Tablet to fransibe Fw admin
FSiHome Make sure the translations of this pa fw admin
Home (de Ensure thal this German transiation T acimin
Home (es Ensure that this Spanesh translation v admin
Home (fr Ensure that this French transiation o fw admin

——

8.4 Reviewing Translated Content

When an asset returns from translation and is ready for you to review, it is displayed in your Assignments list
on the Home tab of the dashboard of the Contributor interface:

L] Assignments (7) #+ 9

Asset lame & Action to Take Assigned by Due (Days)

F5iFrms lakeStep HEVISW Cransiation T admin
FSiFirmsTakeSiep Review branslalio T admin

FSliFrmsTake Siep Reviev tramslation v admin

FSiiHome Klaka sure the translations of thie pa T admin
Home (de) Engure 1hal this German transiation T admin
Home (es Ensure that this Spanish translation T admin

Home (f Ensure that this French translation o T admin

Note: Depending on the CT: Approval for Content workflow is configured in your company, you may
also receive an email notification.

To review translated content:

1. Inyour Assignments list on the Home tab of the dashboard of the Contributor interface, click the Review
translation link.

The Content page for the asset opens.
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8.4 Reviewing Translated Content

Name:

Description:

Status:

Created:

Maodified:

Workflow commands:

Content: FSITFirmsTakeStepTowardCompatibleGadgets

FSIIFrms TakeStep TowardCompatibleGadgets

Entreprises prennent étape vers gadgets compatibles

Edited

Thursday, January 8, 2015 10:58:09 AM EST by fwadmin

Friday, March 20, 2015 10:58:56 AM EDT by fwadmin

<Select Workflow Action> -

Gndcﬂuw process:

CT: Approval for Content - CT: Translated, Pending -’xn:urm)

Workflow state:

Assigned to Assigned by Assigned date Action to Take

Step Chosen  Task Status

el T DGR T e

The Workflow process field displays both the name of the workflow process, CT: Approval for

Content, and the workflow state, CT: Translated, Pending Approval.

dropdown list, select Finish My Assignment.

To proceed to the next step and move the asset through the workflow, in the Workflow commands

Note: For descriptions of the other options, refer to the appropriate version of the OWCS documentation at
http://www.oracle.com/technetwork/middleware/webcenter/sites/documentation/index.html.
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Content: FSITFirmsTakeStepTowardCompatibleGadgets

Created:

Modified:

Workflow commands:
Workflow process:

Workflow state:

FEIFrrs TakaStep TowardCompatibleGadgets

Entreprises prennent étape vers gadgets compatibles

Edited

Thursday, January 8, 2015 10:58:09 AM EST by fwadmin

Friday, March 20, 2015 10:38:56 AM EDT by fwadmn

<Select Workflow Action> |;

=Select Workflow Action>
Finish My Assignment

ranslated, Pending Approval
Show Paricipants

Assigned date Action to Take Step Chosen  Task Status

Remove from Warkflow

SetAssignmentDeadline | 3/20/15 10:58 AM  Review transition

The Finish My Assignment for Content page opens.
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8.4 Reviewing Translated Content

Content Name;

Description:

Workflow Process:

Assigned User Role:

Finish My Assignment for Content: FSIIFirmsTakeStepTowardCompatibleGadgets

FSIIFirms TakeStep TowardCompatiblkeGadgets

Entreprises prennent etape vers gadgets compatibles

CT: Approval for Content - CT: Transkted, Pending Approval

I . -
(Unknown)

*Choose Step -> State:

CT: Approve Transbtion -= (nul state)

CT: Resend for Translation -> CT: Pending Transkation

Action Taken:

Action to Take:

Cancel Finish My Assignment

3. Do one of the following:

If you approve the translation, click CT: Approve Translation -> (null state) to end the workflow.

Note: If your workflow has been configured for additional workflow steps before publishing, for example,
a legal review, then after the arrow, then the name of the custom step is displayed after the arrow,

instead of (null state).

If you do not approve the translation, and you want to send it back to translation, click CT: Resend for
Translation -> CT: Pending Translation. This changes the state of the asset back to CT: Pending

Translation.
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Ea

Optional. In the Action Taken field, enter a short description of the work you completed on the asset.
5. Optional. In the Action to Take field, enter brief instructions for the person receiving the assignment.

6. Click Finish My Assignment.
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9 Administrative Tasks

This section lists and describes the administrative tasks you can perform in the Clay Tablet Dashboard interface.
Some of these tasks are very similar to tasks performed in the Contributor interface. In those cases, there are
links to the relevant sections elsewhere in the guide, where there are descriptions of the differences between
both interfaces.

You can perform the following administrative tasks in the Clay Tablet Dashboard interface:
viewing the status of translation jobs and assets

Under Management, click View All Jobs to open the Translation Jobs page. For a detailed description of this
page and the related Job Details page, see "Monitoring All Translation Jobs" on page 48 and "Monitoring
Assets in a Single Translation Job" on page 51.

viewing the assets in the Translation Queue and adding them to jobs

Under Management, click View All Queues to open the Translation Queue. For a detailed description of the
gueue, see "Adding Assets in the Translation Queue to Jobs" on page 33.

approving translations

Under Management, click View All Jobs to open the Translation Jobs page. Then click a job in the Name
column to open the Job Details page. For detailed instructions, see "Approving Translated Assets" on page
57.

checking the Clay Tablet Platform for messages

Under Utilities, click Check Messages Now to open the Check Messages page. For a detailed description,
see "Checking the Platform for Messages" on page 73.

updating the Clay Tablet Platform with translated files, if the translation provider could not submit them
back to you via the Platform and the Connector

Under Utilities, click Submit Translated Files to open the Submit Translated Files page. For a detailed
description, see "Checking the Platform for Messages" on page 73.

Important: The following functionality that is available to global administrators (users assigned to the CTAdmin
role) in the Clay Tablet Dashboard interface is described in the Clay Tablet Connector for Oracle WebCenter
Sites Installation and Configuration Guide:

Configuration
System Configuration
Site Configuration
Translation Providers

PO Numbers Configuration (also available to site administrators, who are users assigned to the
CTSiteAdmin role)

Utilities

Export Configurations
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Import Configurations
B Locale Tools
Locales and Locale Mapping

#  Assign Locales to Assets

9.1 Checking the Platform for Messages

You can check the Clay Tablet Platform for messages about outstanding translation jobs.

To check the Platform for messages:

1. Inthe Clay Tablet Dashboard interface, under Utilities, click Check Messages Now.
The Checked Messages page opens.
Checked Messages

The Cay Tablet platform was checked successfuly at 2015-02-19 19:56:51.

» Messages processed successfuly: 0

* Messages processed with emor:

# Translation fles processed successfully: 0
« Translation files processed with ermor: O
& Translation jobs updated: 0

= Translation requests updated: 0

# Target asset updated: 0

# Target asset attmbutes updated: 0

View the sites.log fie for more detai of the processing resuks.

This page displays information about messages, files, jobs, and assets currently processed by the Platform. If
any of these are stuck on the Platform, they will be displayed on this page.

For details, view the sites. logfile.

2. To update the results, click Check again at the bottom of the page.

9.2 Submitting Translated Files

Suppose that the translation provider cannot return the translated files to you via the Clay Tablet Platform and
the Connector. For example, this might happen if there is a connectivity issue between the provider and the
Platform. In this scenario, the translation provider can send you the translated files outside of OWCS, for
example by email.
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9.2 Submitting Translated Files

Even though you have received the translated files, it is stillimportant to add these files to the Clay Tablet
system, so that the system will be up to date with the translated files. This means that in the future, you will be
able to use all the Clay Tablet features effectively, such as requesting translation updates, instead of translating

all the previously translated files. This substantially reduces translation time, cost, and effort.

In this scenario, you use the Submit Translated Files utility to add translated files to the Clay Tablet system.

To submit translated files:

1. Inthe Clay Tablet Dashboard interface, under Utilities, click Submit Translated Files.

The Submit Translated Files page opens.

Submit Translated Files

Transiated file(s):

Pleass select 3 transiate fie or 3 ZIP file that contains transkated fies to update the target assats,

| Browse_ | Mo fila selected

i asingle translated file in XML format

# asingle zipped file that contains multiple translated files in XML format

4. Click Submit.
The message Uploadi

Select the file to upload, and close the dialog box. For example, in Firefox, click Open.

ng. .. isdisplayed.
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